Avid® DS

Hi-Res Workflow and Color Guide
Legal Notices

Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

The software described in this document is furnished under a license agreement. You can obtain a copy of that license by visiting Avid’s Web site at www.avid.com. The terms of that license are also available in the product in the same directory as the software. The software may not be reverse assembled and may be used or copied only in accordance with the terms of the license agreement. It is against the law to copy the software on any medium except as specifically allowed in the license agreement.

This document is protected under copyright law. An authorized licensee of Avid DS may reproduce this publication for the licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, for commercial purposes, such as selling copies of this document or providing support or educational services to others. This document is supplied as a guide for [product name]. Reasonable care has been taken in preparing the information it contains. However, this document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not accept responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to change without notice.

Copyright © 2009 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Paradigm Matrix:

Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:

“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s products or the software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised, knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:

“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.”

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source Code:


The following disclaimer is required by Interplay Entertainment Corp.:

The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:

JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection with Avid Interplay.
Attn. Government User(s). Restricted Rights Legend

U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or “commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks


Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other trademarks contained herein are the property of their respective owners.

GOT FOOTAGE?

Editors — Filmmakers — Special Effects Artists — Game Developers — Animators — Educators — Broadcasters — Content creators of every genre — Just finished an incredible project and want to share it with the world?

Send us your reels and we may use your footage in our show reel or demo!*

For a copy of our release and Avid’s mailing address, go to www.avid.com/footage.

*Note: Avid cannot guarantee the use of materials submitted.

Avid DS Hi-Res Workflow and Color Guide • 0130-30207-01 Rev A • August 2009
Contents

Chapter 1 Editing High-Resolution Projects ....................................................... 7
Chapter 2 Color Management ............................................................................. 9
  Lookup Tables (LUTs) .................................................................................. 9
  The Avid DS Color Management Pipeline .................................................. 14
Chapter 3 Film-based Workflows ................................................................. 19
  Workflow: Finishing of Digital Film Footage .............................................. 19
  Workflow: Finishing of Film Reel Footage ................................................ 23
Chapter 4 Setting up Storage and Media for Film Projects ......................... 27
  Placing High-Resolution Media on the Storage Device ............................ 27
  Opening the Media Storage Configuration Tool outside Avid DS .............. 28
  Defining your Storage Areas within the Media Indexing Service ............ 29
Chapter 5 Editing Film-based Projects ......................................................... 35
  Opening a Film-based Project ................................................................... 35
  Conforming a Film Sequence using an AFE ............................................. 38
  Conforming a Film Sequence using an EDL ............................................. 40
  Linking to High-Resolution Files .............................................................. 42
  Capturing High Resolution Media from Tape ......................................... 48
  Capturing Film-based Media from File ................................................... 53
  Viewing High-Resolution Sequences ....................................................... 55
  Film Proxy Mode ..................................................................................... 57
  Outputting Film Sequences ...................................................................... 59
Chapter 6 Using Lookup Tables ................................................................. 65
  Customizing LUTs .................................................................................... 65
  Importing External LUTs ......................................................................... 66
  Saving and Exporting a LUT File ............................................................. 67
  Enabling a LUT to the Avid DS Viewer ................................................... 68
  Applying a LUT Effect ............................................................................. 68
  Generating 3D LUTs ................................................................................ 70
Chapter 7  Using Avid MetaFuze ......................................................... 73
  Film and High-Resolution Workflows using MetaFuze .................. 73
  Opening a Project in MetaFuze ............................................... 75
  Customizing the MetaFuze Window ......................................... 75
  Scanning your Folders ....................................................... 77
  Transcoding your Files ..................................................... 79
  Configuring the MetaFuze Transcoder ................................... 85
  Using LUTs in MetaFuze ..................................................... 86
  Transcoding your Files in a Batch ....................................... 88
  Exporting an ALE from MetaFuze ......................................... 93
  Importing MXF Files into Avid Media Composer ....................... 93
  Exporting the AFE File from Avid Media Composer ................... 95

Chapter 8  Avid MetaFuze Reference ........................................... 97
  Scan Folders Dialog Box .................................................... 97
  Group View ................................................................. 99
  Detail View ............................................................... 103
  Details of a group ....................................................... 104
  Details of a file ........................................................ 105
  Details of a transcode job .............................................. 106
  Details of a stereoscopic group or transcode job .................... 108
  Details of R3D groups or transcode jobs ............................... 109
  Create XML Batch Dialog Box ........................................... 109
  Burn-in Editor Dialog Box ................................................ 110
  Transcode Configuration Options ..................................... 110
Editing High-Resolution Projects

Avid DS provides an easy and cost-effective way to manipulate high-resolution digital motion picture images during the finishing and mastering stages of post production.

Due to recent advances in cinematography, digital cameras, like the Red One, are starting to have an impact on the film-creation industry as they allow you to bypass the film lab conversion process, and load your footage directly onto your online editing system. As a result, films can now be produced digitally from start to end using an all-digital format.

Avid DS also provides an easy transition from tape-based conform to file-based conform. Therefore, productions may choose to start as film-to-tape, transition to the dual existence of tape-based and file-based, and then finish as file-based for the mastering and delivery requirements.

The following illustration shows the key steps for editing and finishing footage that originated either from film reel or file.
1 Editing High-Resolution Projects

Step 1: Acquisition

If the footage comes from a traditional film reel, it needs to be scanned to DPX files, or transferred through Telecine onto tape in a digital HD format. On the other hand, footage that is already in digital file format from digital video cameras or film scanning processes (e.g. R3D, DPX) can be loaded directly onto the editing system. All source material in digitized form can either be in 2K, 4K, or HD-RGB 4:4:4 format, which all provide superior image quality.

This document refers to DPX (Digital Picture eXchange) as it is a common file format used to store a single motion picture frame to a file. Other formats such as Cineon are also supported by Avid DS.

Step 2: Offline Editing

If you want to offline in Avid Media Composer, start by using Avid MetaFuze to convert your high-resolution files (DPX, R3D, TIF) into MXF media files in an HD resolution. You can then import the MXF files into Avid Media Composer for offline editing.

After editing the sequence, export it as an AFE in order to take it to Avid DS for finishing.

Step 3: High-Resolution Effects & Finishing

The effects and finishing workflow for high-resolution files can be conducted either of the following ways:

- Doing all the editing and finishing the project directly in Avid DS by linking or capturing the high-resolution media, or
- Doing the offline edit in a system such as Avid Media Composer, and conforming into Avid DS for finishing.

When working with high-resolution media, Avid DS handles the complicated task of preserving color settings during the transfer and storage of the media. This is known as color management and it is achieved by applying lookup table files (LUTs). For more information see “Color Management” on page 9.

Step 4: Output and Distribution

Universal Mastering in Avid DS gives you the ability to output the film-based sequence to any SD or HD format. In cases where you need a film out, you can easily output to a series of DPX files for film recorder compatibility.
When high-resolution files are transferred through the Telecine process to tape or scanned to DPX files, the storage of color data can be compromised. Furthermore, the different types of monitors used in post-production sites when editing and finishing clips can display inconsistent color data or information.

Proper color management requires that the monitors are calibrated to give editors and artists a uniform view of the footage being used. Color management in Avid DS ensures that the color information from acquisition (capture) to delivery (output) is accurate, consistent, and undistorted. Additionally, it helps guarantee that the colors of the output, even when footage is acquired from different sources, is standardized across all display devices such as CRT and LCD monitors or projectors. This guarantee is accomplished with the use of Lookup Tables (LUTs).

Before you begin using LUTs in Avid DS, do the following:

- Familiarize yourself with the “Editing High-Resolution Projects” on page 7.
- Profile all monitors being used at the site to get the existing color data being displayed, and then calibrate the monitors according to the site’s workflow. This preliminary practice ensures consistent color display on all monitors.
- Clearly understand the type of final output that the client wants as this determines the LUT file that will be applied. For example, the client may want the final output to be broadcast on television, projected in the cinema, or both.

**Lookup Tables (LUTs)**

A LUT is a file that contains a conversion table used to map an input color value to an output color value.

In Avid DS, LUTs are used for the following reasons:

- To ensure a standardized color output value across different devices such as computer monitors, broadcast monitors, and film projectors.
- To offer flexibility in editing and post-production when working with media from different sources or shot with different cameras.
- To convert logarithmic media files to linear format prior to editing and applying effects.
2 Color Management

- To determine how the color data of the final image will be displayed.
- For creative or artistic purposes to obtain a particular “look and feel” to a scene.

Avid DS supports two different types of LUT formats:

- 1D LUT: A 1-dimensional lookup table maps each input channel value to an output channel value on a per-channel basis (independently for each channel R, G, and B). LUT formats from Apple, Autodesk, Avid, and Nucoda are supported.

- 3D LUT: A 3-dimensional lookup table maps any given color value (R,G,B) to an output color value (R, G, B). Mistika, Thomson Luther, Kodak KDM, Iridias formats are supported.

Since high-resolution media can originate from a traditional film reel or from more recent technology such as a digital camera, there are a number of ways to preserve the color values in this media. There are three common acquisition methods:

**Film Transferred to HD Tape**

After the initial chemical development stage of the original color negative, footage originating from traditional film cameras can be transferred through Telecine onto a tape in HD format. The media from film has a LUT file that is determined by the color management and calibration process during the transfer process from film to tape.

Example: Footage for television is shot and transferred to a tape in HD RGB 4:4:4 format. The LUT is delivered with the footage.

**Film Scanned to High-Resolution Files**

Film-reel footage from a camera is scanned at a film-scanning facility to a series of logarithmic-based files. The facility delivers a series of file-based media such as DPX with an accompanying LUT that was used for color calibration and the calculation of how the film scanner interpreted the film stock’s density and color data.

Example: Footage is sent to a film-scanning facility from which a series of DPX or Cineon files are produced. These files are then packaged and sent to the post-production site for editorial and special effects work. The LUT is delivered together with the series of files.

**High-Resolution Files from a Digital Camera**

Digital footage comes directly from the digital camera in a series of linear-based files. This media has a corresponding LUT. For example, R3D files from a RED ONE camera will have their own LUT.
Example: Footage is shot using the RED camera and stored as compressed linear-based native R3D files. An RLX file, generated at the time of acquisition, can also be loaded to provide additional color information of the new footage. (This RLX file can be imported at the same time you import the RED media.)

**Industry LUT Presets Available in Avid DS**

Avid DS provides a list of industry LUT presets that you can use when starting a new sequence or capturing media. Refer to this table for the default values of the Black and White points and the Gamma. For example, if you start a new sequence in 8-bit and you select ITU 601/709, color values of 16 are mapped to black in Avid DS.

<table>
<thead>
<tr>
<th>LUT Presets</th>
<th>Description</th>
<th>Default Black point (8-bit/10-bit)</th>
<th>Default White point (8bit/10bit)</th>
<th>Default Gamma</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear</td>
<td>Creates a linear curve letting you adjust the black and white points only. The gamma value is always 1 and cannot be adjusted.</td>
<td>0/0</td>
<td>255/1023</td>
<td>1</td>
</tr>
<tr>
<td>Linear Video</td>
<td>Creates a linear curve letting you adjust the black and white points only which by default are set to the standard video levels.</td>
<td>16/64</td>
<td>235/940</td>
<td>1</td>
</tr>
<tr>
<td>ITU 601/709</td>
<td>Used with both SD and HD workflows. SD uses 601 values, while HD uses 709 values.</td>
<td>16/64</td>
<td>235/940</td>
<td>2.2</td>
</tr>
<tr>
<td>DCI Gamma</td>
<td>Similar to ITU 601/709, it creates a straight gamma 2.6 but without a linear breakpoint or linear segment. Used for the DCI workflow.</td>
<td>0/0</td>
<td>255/1023</td>
<td>2.6</td>
</tr>
</tbody>
</table>
2 Color Management

### Custom or Camera LUT Presets

Avid DS also provides custom LUTs that are optimized to work with specific industry cameras such as the RED, Viper, and Panavision cameras. For example, the REDLOG LUT has been optimized for the RED Camera sensor and is the best choice for preserving most of the color data in the R3D file during capture in Avid DS. These custom/camera LUTs are found in the `/DS_v10.x/Luts/Lut presets` folder and can be used if one has not been provided with your footage.

The following table describes the custom/camera LUTs that are available in Avid DS:

<table>
<thead>
<tr>
<th>LUT Presets</th>
<th>Description</th>
<th>Default Black point (8-bit/10-bit)</th>
<th>Default White point (8bit/10bit)</th>
<th>Default Gamma</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing Density</td>
<td>Used mostly with Cineon or DPX files that derive from the film scanning process.</td>
<td>23/95</td>
<td>171/685</td>
<td>1.66</td>
</tr>
<tr>
<td>sRGB</td>
<td>The gamma is similar to ITU 601/709. Used mostly when working with standard and CRT monitors, for example to create movies for the web.</td>
<td>0/0</td>
<td>255/1023</td>
<td>2.2</td>
</tr>
<tr>
<td>Legacy Graphics</td>
<td>Creates a linear curve letting you adjust the black and white points as well the black and white gain values.</td>
<td>0/0</td>
<td>255/1023</td>
<td>2.2</td>
</tr>
</tbody>
</table>

### Printing Density

- **Default Black point** (8-bit/10-bit): 23/95
- **Default White point** (8bit/10bit): 171/685
- **Default Gamma**: 1.66

### sRGB

- **Default Black point** (8-bit/10-bit): 0/0
- **Default White point** (8bit/10bit): 255/1023
- **Default Gamma**: 2.2

### Legacy Graphics

- **Default Black point** (8-bit/10-bit): 0/0
- **Default White point** (8bit/10bit): 255/1023
- **Default Gamma**: 2.2

---

Viper

Normalizes images shot using the Thomson Viper Camera. This LUT is used only when the camera is in RGB 4:4:4 filmstream mode.

Note that this LUT linearizes the logarithmic color data from the Viper Camera without affecting the white balance. Use the color correction effect to balance the white color value in the image.
External Monitoring LUT Presets

If you are using an external broadcast monitor that accepts LUTs, you can upload external monitor presets from the /DS_v10.x/Luts/External Monitoring Luts folder.

The following table describes the external monitor LUTs available in Avid DS:

<table>
<thead>
<tr>
<th>External Monitor LUT</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viper2ITU709_viewer</td>
<td>Converts Viper output colors (in the Viper LUT file) to ITU709 on the external monitor.</td>
</tr>
<tr>
<td>RedLog2ITU709_viewer</td>
<td>Converts RedLog output colors (in the RedLog LUT file) to ITU709 on the external monitor.</td>
</tr>
<tr>
<td>PDLLog9852ITU709</td>
<td>Converts PDLLog985 output colors (in the PDLLog985 LUT file) to ITU709 on the external monitor.</td>
</tr>
<tr>
<td>PD2ITU709_viewer</td>
<td>Converts Printing Density output colors (in the Printing Density LUT file) to ITU709 on the external monitor.</td>
</tr>
<tr>
<td>Panalog2ITU709_viewer</td>
<td>Converts Panalog output colors (in the Panalog LUT file) to ITU709 on the external monitor.</td>
</tr>
</tbody>
</table>
2 Color Management

The Avid DS Color Management Pipeline

It is important to understand the color management pipeline in Avid DS, and where and when you need to apply LUTs. The following section provides an overview of the process. If you need detailed steps on actually conducting the process, see “Film-based Workflows” on page 19.

As shown in the diagram, there are different stages in the workflow where a LUT can be set. For the most part, Avid DS applies an appropriate LUT, however you do have the flexibility to change the default LUT when you create a new sequence, at capture, during the editing stage, and at output.

Step 1: Open a New Project/Sequence

Before you start a project, you should know the delivery format of the final output. This is key in determining the LUT that you will set when you start a project. In Avid DS, this is known as the Sequence LUT. For example, if the material you are editing and finishing is for HD television, then the Sequence LUT should be ITU 601-709. If you are delivering for film projection, then you can use Printing Density.

By default, the LUT set for the project is used for all sequences within that project. However, you can change the LUT for individual sequences within the project.
When you are editing in Avid DS, the Sequence LUT is used for the following:

- Encoding the color information that is displayed on the external monitor.
- Generating caches when applying and processing effects in the sequence.
- Outputting to tape.

For more information, see “Opening a Film-based Project” on page 35.

**Step 2: Capture/Link Media**

Any media that is captured, must be converted to a linear representation so that it can be used in Avid DS. When capturing media, you need to know how your media originated so that you can use the appropriate LUT when capturing or linking to that media. The LUT that accompanies the footage is known as the Masterclip LUT in Avid DS. It defines the mapping of the logarithmic values representing each pixel’s color values to a linear color space value.

If you have been given a LUT with your media, then it needs to be applied when you capture or link to the media so that the original color data of the captured material is preserved. When using media from different cameras or sources, make sure that you are using the correct LUT with the correct media during capture.

Although RGB 4:4:4 media is linearized at capture time, it is still stored as logarithmic-based data. An internal storage LUT, controlled by Avid DS, is used to convert the linear-based media to logarithmic-based media for storage.

*The only exception is when capturing R3D files. You can select RED LOG storage LUT that should be used via the RED Import Dialog Box. R3D files are already in a linear-based format, however this LUT optimizes the visual quality of color data for a 16-bit image that needs to be stored in 10-bit.*

**Step 3: Edit the Sequence**

When editing the sequence, there are three places where you can apply a LUT:

- On the Avid DS viewer
- On an external broadcasting monitor
- On the timeline as an effect

**The Avid DS Viewer and the Viewer LUT**

When editing a sequence, you need to keep in mind that Avid DS works in linear color space. Most computer monitors expect sRGB gamma which is why a Viewer LUT is required to convert linear images to the viewer gamma settings. As a result, you may not be
seeing the colors intended for final delivery and you will need to apply a LUT on the Avid DS viewer. By default, sRGB is used, however, you can change the Viewer LUT according to your monitor characteristics.

The Viewer LUT does not affect or encode the final output. The Sequence LUT will still be used at output.

For more information, see “Industry LUT Presets Available in Avid DS” on page 11 and “Enabling a LUT to the Avid DS Viewer” on page 68.

The External Broadcast Monitor LUT

Most post-production sites use an external broadcast monitor to view the final output. External monitors have their own LUTs to convert images coming from Avid DS into the color space of the external monitor. This LUT is applied on the external monitor only and not processed by the Avid DS system.

Avid DS provides external monitor LUT presets that you can load on your external monitor using a USB key or a similar hardware device. (Consult your external monitor’s documentation for procedures for uploading LUTs.) These LUTS can be found in the /DS_v10.x/Luts/External Monitoring Luts folder. For descriptions of these LUTs, see “External Monitoring LUT Presets” on page 13.

The LUT Effect

If you are an Avid DS colorist and prefer to color correct on logarithmic-based media, the color management process in Avid DS provides this flexibility by letting you apply the LUT effect from the image effects library.

Typically, when a LUT is applied during capture, logarithmic media from a camera or file is linearized. This is because compositing, titling, and the application of effects in Avid DS requires that the media be linear.

If you want to work in logarithmic space, when color correcting for example, you can manually apply a LUT effect to convert to logarithmic and then back to linear to complete the editorial. However, you can convert the clips back to apply special effects, or for color correction work. For more information, see “Applying a LUT Effect” on page 68.
Step 4: Output the Sequence

You can output the finished sequence to tape or digital files such as DPX or Cineon. By default, Avid DS uses the Sequence LUT that you set when you started the sequence for the following reasons:

- The sequence has been using this LUT to encode the media and generate caches when working on the timeline.
- The Sequence LUT ensures that the stored color information is correct and properly displayed on an external monitor or film projector.

When outputting to tape, the Sequence LUT is automatically used. When outputting to file, you can apply any LUT. For more information, see “Outputting Film Sequences” on page 59.

You can also apply a 3D LUT when you are outputting to Cineon and DPX files.
2 Color Management
When using Avid applications, there are two main ways in which you can work with film and other high-resolution media.

- If you are editing footage that originated on film reel and was transferred to HD tape for editing, then refer to “Workflow: Finishing of Film Reel Footage” on page 23.
- If you are editing high-resolution files generated from digital cameras, film-scanning facilities, or CGI applications (e.g. R3D, DPX, TIF), then refer to “Workflow: Finishing of Digital Film Footage” on page 19.

### Workflow: Finishing of Digital Film Footage

This workflow shows you how to do the finishing on footage that is already in digital file format. High-resolution files could originate from digital film cameras, film-scanning facilities, or CGI applications. The files include R3D, DPX, or TIF.

You can edit and finish these files directly in Avid DS. We refer to this as online editing.

Alternatively, you can do your offline editing via Avid Media Composer using low-resolution media, and then do the online editing in Avid DS. To use the high-resolution files in Avid Media Composer, they need to be converted into playable media using Avid® MetaFuze™. MetaFuze merges consecutive single-frame files (with metadata contained as part of the format) into an MXF file that can be read by Avid Media Composer®.

MetaFuze also reads other file types supported by Avid DS or third-party parsers.

The illustration below shows a typical example of a file-based workflow for editing digital footage on Avid DS and/or Avid Media Composer.
Step 1: Group high-res files into MXF files

If you want to offline in Avid Media Composer, start by using MetaFuze to convert the DPX/R3D/TIF files into MXF files in an HD resolution. Import this MXF into Avid Media Composer for offline editing.

Step 2: Edit and produce final AFE

After editing the sequence on Avid Media Composer, export the sequence as an AFE for the finishing on Avid DS.

When exporting your sequence for conform, there are some details to be considered. We recommend that you read the following whitepapers available at www.avid.com:

- Using HD-RGB with Film in HD-based DI Workflows
- Avid/RED Workflow Guide

Step 3: Conform AFE

On Avid DS, you can conform the AFE and connect to the original DPX/R3D/TIF files.

In the case of DPX files, necessary information such as KeyKode™ (key number) and timecode is inserted as metadata into the DPX file during the scanning process. If the DPX files do not contain the timecode information, the ALE is required in order to make the necessary correspondence to the associated DPX files. The ALE is usually supplied by the film-scanning facility or output by MetaFuze/Avid Media Composer.
The MXF file is not required for the finishing process but it could be imported onto a separate video track in Avid DS and used as part of the conform check process.

Depending on your system configuration, many high-resolution formats are playable in real time—for a specific list of these formats, see the Avid DS support web at www.avid.com. When editing high-resolution projects where real-time playback is not achievable, you can use the proxy mode to apply effects and view the results in HD 4:2:2 or HD 4:4:4.

Step 4: Output to tape or file

You can output the final sequence to master as a series of DPX or Cineon™ images (with an appropriate LUT) for a film recorder. You can also output any other SD or HD formats as required.

Checklist: Finishing of Digital Film Footage

The following checklist is a guide to all the procedures to which you will need to refer. Follow these steps in the order that they are listed. They will lead you to more detailed procedures, so make sure you return to this checklist each time you complete a step.

<table>
<thead>
<tr>
<th>Step</th>
<th>Refer to this section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Avid MetaFuze and scan your folders.</td>
<td>“Scanning your Folders” on page 77.</td>
</tr>
<tr>
<td>Transcode your high-resolution files into an MXF file.</td>
<td>“Transcoding your Files” on page 79.</td>
</tr>
<tr>
<td>If you have multiple MXF files, export an edit list of all these clips via an ALE.</td>
<td>“Exporting an ALE from MetaFuze” on page 93.</td>
</tr>
<tr>
<td>Import the MXF file(s) into Avid Media Composer.</td>
<td>“Importing MXF Files into Avid Media Composer” on page 93.</td>
</tr>
<tr>
<td>Perform the offline edit to produce the final sequence.</td>
<td></td>
</tr>
<tr>
<td>Export an AFE of your final project or sequence from Avid Media Composer.</td>
<td>“Exporting the AFE File from Avid Media Composer” on page 95.</td>
</tr>
</tbody>
</table>

You should first make a copy of the sequence, move it to its own bin, decompose it (with handles as desired), select ALL master clips, and export as ALE with appropriate columns visible in the bin.
If you are working with R3D/DPX files, do not use the option to extend handles beyond the master clip edges.

To edit in Avid DS:

- Learn how to set up your workgroup so that you can share media between workstations. “Defining your Storage Areas within the Media Indexing Service” on page 29.
- Make sure the high-resolution files reside on a high-capacity storage. “Placing High-Resolution Media on the Storage Device” on page 27.
- If you are working with different types of high-resolution media (e.g. R3D, DPX, TIF), make sure that they are each placed in different folders.
- Make sure that your storage has been configured to have read/write access for your high-resolution files. “Opening the Media Storage Configuration Tool outside Avid DS” on page 28.
- Open a new project for film or HD. “Opening a Film-based Project” on page 35.
- If you are starting your project directly in Avid DS, then link to your clips and start building your sequence. “Linking to High-Resolution Files” on page 42.

or

- If you are conforming a sequence from Avid Media Composer, then open the AFE or EDL. “Conforming a Film Sequence using an AFE” on page 38, or “Conforming a Film Sequence using an EDL” on page 40.
- If you are linking to DPX files and they do not contain the timecode information, then you will also need the ALE (either from the film house, MetaFuze or Avid Media Composer) to make the necessary correspondence to the associated DPX files.

- Perform the necessary editing. “Film Proxy Mode” on page 57.
- Add special effects and do the necessary color correction. Refer to the appropriate sections in the Help.
- Process your sequence. Refer to the Processing section in the Help.
- Output your sequence to the format(s) required. “Outputting Film Sequences” on page 59.
Workflow: Finishing of Film Reel Footage

This workflow shows how you can carry out your finishing on footage that originated on film reel and was transferred to tape for offline editing.

When footage is shot on film, it can be digitized in one of two ways. It can be scanned to DPX files to preserve the 2K or 4K film resolution, or it can be transferred to tape in HD 4:4:4 format.

Since scanning film to DPX is a costly process, it is better to offline your sequence to save the time and expense of transferring all the raw film footage to high-resolution files. The workflow shown here uses low-quality dub tapes to do the offline editing on Avid Media Composer, and then transfer/scan only the necessary footage onto HD tape or DPX files. Either the HD tape or the DPX files can then be captured or linked in Avid DS for the finishing.

The illustration below shows a typical example of a tape-based workflow for editing film footage on an Avid Media Composer and Avid DS.

**Step 1: Dub film reels to tapes for first pass**

To offline in Avid Media Composer, transfer the film reels through a telecine onto tape. If you have a Avid Media Composer HD system, you can do your offline editing with an HD work tape. Otherwise, transfer to a lower-quality SD work tape.
Step 2: Do rough edit and send for second pass

Avid Media Composer uses an ALE, which is produced during the telecine transfer, to capture source video from the dub tape. After the rough edit is done, generate an MXF file, an AFE of the sequence, a new ALE, and a film pull list in order to do a second pass and transfer only the necessary material.

Step 3: Scan/telecine only necessary material

The film transfer facility uses the film pull list to scan the edited footage to single-frame DPX files. This transfers only the necessary material to file which minimizes costs and also makes for a more efficient final online edit and finish in Avid DS.

Alternatively, the film pull list can be used to do a final, high-quality pass through the telecine to HD 4:4:4 tape.

Step 4: Edit and produce final AFE

If you generated an HD tape from the second pass, then you can do further edits in Avid Media Composer and then export a final AFE to take to Avid DS for the finishing.

Step 5: Conform AFE

Conform the offlined sequence into Avid DS using the AFE. If you are working from an HD 4:4:4 tape, then capture the media into Avid DS.

If you are linking to DPX files, necessary information such as KeyKode (key number) and timecode was inserted as metadata into the DPX file during the scanning process. If the DPX files do not contain the timecode information, the ALE is required in order to make the necessary correspondence to the associated DPX files. The ALE is usually supplied by the film-scanning facility or output by MetaFuze/Avid Media Composer.

*The MXF file is not required for the finishing process but it could be imported onto a separate video track in Avid DS and used as part of the conform check process.*

Depending on your system configuration, many high-resolution formats are playable in real time—for a specific list of these formats, see the Avid DS support web at www.avid.com. When editing high-resolution projects where real-time playback is not achievable, you can use the proxy mode to apply effects and view the results in HD 4:2:2 or HD 4:4:4.

Step 6: Output to tape or file

You can output the final sequence to master from Avid DS as a series of DPX or Cineon images for a film recorder, or any other SD or HD formats as required.
## Checklist: Finishing of Film Reel Footage

The following checklist is a guide to all the procedures to which you will need to refer. Follow these steps in the order that they are listed. They will lead you to more detailed procedures, so make sure you return to this checklist each time you complete a step.

<table>
<thead>
<tr>
<th>Step</th>
<th>Refer to this section</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>If you are offlineing your sequence in Avid Media Composer:</strong></td>
<td></td>
</tr>
<tr>
<td>• Use the ALE produced during the Telecine transfer to capture source video from the dub tapes into Avid Media Composer.</td>
<td></td>
</tr>
<tr>
<td>• Perform the offline edit to produce the final sequence.</td>
<td></td>
</tr>
<tr>
<td>• Export an AFE of your final project or sequence from Avid Media Composer. (You should first make a copy of the sequence, decompose it, and then export the bin).</td>
<td>“Exporting the AFE File from Avid Media Composer” on page 95.</td>
</tr>
<tr>
<td>• Generate a film pull list from FilmScribe. The film transfer facility will use the film pull list to scan the necessary footage to DPX files. Alternatively, the film pull list can also be used to do a final, high-quality pass through the telecine to HD 4:4:4 tape.</td>
<td></td>
</tr>
<tr>
<td><strong>To edit in Avid DS:</strong></td>
<td></td>
</tr>
<tr>
<td>• Learn how to set up your workgroup so that you can share media between workstations.</td>
<td>“Defining your Storage Areas within the Media Indexing Service” on page 29.</td>
</tr>
<tr>
<td>• If you are working with high-resolution media, make sure the files reside on a high-capacity storage.</td>
<td>“Placing High-Resolution Media on the Storage Device” on page 27.</td>
</tr>
<tr>
<td>• Configure access to the storage where the high-resolution files are located.</td>
<td>“Opening the Media Storage Configuration Tool outside Avid DS” on page 28.</td>
</tr>
<tr>
<td>• Open a new project for film.</td>
<td>“Opening a Film-based Project” on page 35.</td>
</tr>
<tr>
<td>• If you are working with media from tape, capture your HD 4:4:4 footage into Avid DS.</td>
<td>“Capturing High Resolution Media from Tape” on page 48.</td>
</tr>
</tbody>
</table>
### 3 Film-based Workflows

<table>
<thead>
<tr>
<th>Step</th>
<th>Refer to this section</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ If you are conforming a sequence from Avid Media Composer, then open the AFE or EDL.</td>
<td>“Conforming a Film Sequence using an AFE” on page 38, or “Conforming a Film Sequence using an EDL” on page 40.</td>
</tr>
<tr>
<td>☐ Find the associated high-resolution files.</td>
<td>“Linking to High-Resolution Files during the Conform Session” on page 44.</td>
</tr>
<tr>
<td>If you are using DPX files and they do not contain the timecode information, then you will also need the ALE (either from the film house, MetaFuze or Avid Media Composer) in order to make the necessary correspondence to the associated DPX files.</td>
<td></td>
</tr>
<tr>
<td>☐ Perform the necessary editing.</td>
<td>“Film Proxy Mode” on page 57.</td>
</tr>
<tr>
<td>☐ Add special effects and do the necessary color correction.</td>
<td>Refer to the appropriate sections in the Help.</td>
</tr>
<tr>
<td>☐ Process your sequence.</td>
<td>Refer to the Processing section in the Help.</td>
</tr>
<tr>
<td>☐ Output your final sequence to tape or file.</td>
<td>“Outputting Film Sequences” on page 59.</td>
</tr>
</tbody>
</table>
4 Setting up Storage and Media for Film Projects

Since film-based media is large, it requires high bandwidth and fast disk access. You must ensure that you have storage that is large and fast enough for high throughput so that you can play your sequence in realtime. (Typically, 2K data takes up over 1 TB per hour of footage.)

The Avid DS Support Center web site provides a complete list of storages supported for film-based media, and indicates which types of storage provide realtime capability.

If you need to transfer or share projects and media for offline-to-online production between Avid systems, you can set up shared storage with Avid Media Composer. MXF sequences offlined on an HD-capable Avid Media Composer can be previewed directly in Avid DS using the real-time proxy resolution (film proxy mode).

Before you begin working on your projects, you must plan out your storage solutions carefully so that you can share media between Avid applications—see “Sharing Media” in the Help.

Placing High-Resolution Media on the Storage Device

High-resolution digital footage that comes either from digital video cameras, film scanning processes or CGI applications (e.g. R3D, DPX, TIF), should be placed onto a fast, high-capacity storage device connected to your workstation. This allows you to link to these source files and still get realtime playback in Avid DS.

If this media is being shared with other Avid systems, you can place these master files on a shared storage, such as Avid Unity and link to it.

For a list of storages that support realtime playback, refer to the Avid DS Support Center. You can also place your media on a shared storage and link to it, but you may not get realtime playback unless you process the media.

If you are working with different types of high-resolution media (e.g. R3D, DPX, TIF), make sure that they are each placed in different folders.
4 Setting up Storage and Media for Film Projects

- **For local storage.** Place your high-resolution files in an appropriate folder under the `\VideoStorage` folder on the storage device. For example,

  `\workstation_name\VideoStorage\DPX\Casino\`

- **For shared storage.** Place the high-resolution files on a workspace on Avid Unity. For example,

  `\server_name\workspace_name\Avid MediaFiles\DPX\Casino\`

## Opening the Media Storage Configuration Tool outside Avid DS

Before you begin working on any projects, you must set up your storage. The Media Storage Configuration tool can be accessed inside or outside Avid DS.

### To open the media storage configuration tool outside Avid DS:

1. On your desktop, select **Start > All Programs > Avid > Avid DS v10.x > Tools > Avid DS Support Console**.
   
   The support console and all the various tools are displayed.

2. Double-click **UMMDTest.exe**.

3. Select **File > Open Service**.
   
   A dialog box displays for you to enter the workstation whose storage you want to configure.

4. If you are on the proper workstation then leave the machine name blank and click **OK**.
   
   If you need to configure the storage for another workstation in this workgroup, then enter the name of that workstation.

   **Warning:** There is no security when configuring another workstation’s storage in this way. Therefore, make sure that no one else is using that workstation or they will automatically be disconnected when you log in.

5. Select **File > Configure**.
   
   The Media Storage Configuration - Current Project dialog box displays the media indexing services that were automatically configured for your workstation when Avid DS was installed.

6. See “Defining your Storage Areas within the Media Indexing Service” on page 29 to begin configuring the storage areas.
Defining your Storage Areas within the Media Indexing Service

You must define all storage areas that you need to access inside a configuration called a media indexing service. The Avid DS media indexer scans all storages defined for each workstation and indexes the media for quick and efficient access.

If you are configuring the media indexing service on the controller, see “Accessing Storage on another Workstation” in the Help. The procedure describes how to include storage areas on other Avid DS workstations in the workgroup, so that workstations can access each other’s media.

To define your storage areas in the media indexing service:

1. In Avid DS, select Data Management > Configure Storages.

If you are not running Avid DS, see “Opening the Media Storage Configuration Tool outside Avid DS” on page 28.

The Media Storage Configuration - Current Project dialog box displays the media indexing services that were automatically configured for your workstation when Avid DS was installed.

2. Select your workstation’s media indexing service, and click the Change button.

The Media Indexing Service dialog box displays.
4 Setting up Storage and Media for Film Projects

3. Leave the workstation name as it is and click the Change button.
   The list of storage areas that have already been defined in this indexing service displays. Each storage area is uniquely identified by the workstation name and folder where the media resides.

4. To add a new storage, click the Add button.
5. In the Available Storage Types dialog box, select Avid Media Storage and click OK.
Defining your Storage Areas within the Media Indexing Service

6. Enter the full Windows path name (\workstation_name\folder_name) where the storage area is located, or use the browse (...) button to find it. For example, \DSStorage4\Video.

If you are connecting to a folder on an Avid Unity, then click the browse (...) button and locate the Avid Unity workspace folder. For example, \Unity_server_name\allocation\workspace\folder_name. Do NOT use a drive letter.

7. If you are working in a workgroup where an Avid DS RP is installed, select the Enable throttling for this storage option. The Avid Throttle Manager allows for more efficient bandwidth management between your workstation, storage areas, and the Avid DS RP workstation.
8. If this storage is for sharing MXF media with another Avid editing system such as Avid Media Composer, then select Prevent purge of media on this storage. This makes the storage “read-only”.

9. Select the media type that you will store in this folder:

If there are different media types in your storage, you must add a storage configuration for each different type (e.g. generic audio, generic video, MXF audio, MXF video, etc.)

<table>
<thead>
<tr>
<th>For this storage folder</th>
<th>Select this option(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video media imported or generated media by Avid DS (read/write).</td>
<td>generic video (.gen)</td>
</tr>
<tr>
<td>Audio media imported or generated media by Avid DS (read/write).</td>
<td>generic audio (.wav)</td>
</tr>
<tr>
<td>Media that is going to be read-only, but not overwritten, e.g. OMFI media that will be used by other Avid editing systems.</td>
<td>None</td>
</tr>
</tbody>
</table>

For MXF media: Folders that contain MXF media must be defined separately within your media indexing service.

You need to set up separate MXF folders for Avid DS and any other Avid editing systems—see “Sharing MXF Media” in the Help.

<table>
<thead>
<tr>
<th>MXF audio (purgeable) — Read Only</th>
<th>MXF audio files (.mxf)</th>
</tr>
</thead>
<tbody>
<tr>
<td>MXF video (purgeable) — Read Only</td>
<td>MXF video files (.mxf)</td>
</tr>
</tbody>
</table>
| MXF audio (non-purgeable) | • MXF audio files (.mxf)  
• Prevent purge of media on this storage |
| MXF video (non-purgeable) | • MXF video files (.mxf)  
• Prevent purge of media on this storage |

10. From the Disk Controller Type list, select the card that is installed in your workstation.

11. From the Disk Storage Type list, select the storage type that you are using.

The disk options set the appropriate bandwidth for Avid DS to use when transferring data to the storage. Choose the appropriate options for your storage device to obtain the best performance for real-time effects.

If your storage device does not appear in the list, it may be because it was installed after Avid DS was installed. To make sure that it appears in the list, restart Avid DS so that the software detects the device.
12. Click OK.

The storage area is added to the Media Storage Configuration list.

13. Continue to add storage areas for all folders to which you need access.

If there are different media types in your storage, you must add a storage configuration for each different type (e.g. generic audio, generic video, MXF audio, MXF video, etc.)

14. Storages are accessed and indexed in the order in which they are listed. Use the Move Up or Move Down buttons to change the order of priority.
15. Click Close and then OK to return to the Media Storage Configuration - Workstation dialog box.

16. Click Close and then OK to return to the Media Storage Configuration - Workstation dialog box.

17. Click the Close button to save the configuration for the media indexing service.

*By default, the media indexer sets any new storage areas to automatically have full read/write access by any user on the network. To restrict access to your media, you can change the share permissions through Windows—see “Sharing Folders and Setting Permissions” on page 57.*

The first time that you configure your storage, the media indexer will need to index the media on your storage device. This may take a while depending on the amount of media on your storage.

18. Once your storages have been indexed, you should stop and restart the media indexer—see “Stopping and Starting your Avid Indexing Services” in the Help.
Edited Film-based Projects

As there are a number of different ways to work with film-based projects, it is recommended that you first read “Film-based Workflows” on page 19 and follow the workflow that best meets your project requirements. You should also read the material in “Color Management” on page 9.

Opening a Film-based Project

Avid DS can work with HD and 2K/4K files, including a large number of sequence formats for various film resolutions and aspect ratios.

To set your project settings accurately when you open a project in Avid DS, you must gather the following information from either the film-scanning facility, the camera operator, or the production director:

- The original film format of your media (e.g. 1080, RED, Full Aperture, DPX, Cineon).
- The quality at which your film master was scanned or transferred. The most popular is the 10-bit format and the most frequently used resolution is 2K.
- The frame rate (fps) at which your film master was scanned or transferred.
- The format required for final delivery.
- A corresponding LUT for your footage. This will be required when you import your media into Avid DS.

To create a film-based project:

1. In the Open Project dialog box that displays when you start Avid DS, click the New Project button.

   The New Project dialog box displays. You can click the Help button at any time to get a full description of all the parameters in this dialog box.

2. Enter a Project Name.

3. Keep the default project Location as this is where all your Avid DS projects reside.

4. There are a number of film resolutions and apertures for HD or film that you can choose from.
5 Editing Film-based Projects

Select the specific film Format at which your material was acquired. The menu options are as follows—Media Format > Resolution > Frame rate.

For example:
FILM > RED > 2:1 (2K) > 23.97 frames/s
HD RGB 4:4:4 > 1080i > 59.94 fields/s

If you are going to output your project at a different resolution then what it was originally shot at, then you can set the project with the new output format. Note however, that if your media format is not the same as your sequence format, your media will not be playable in realtime in Avid DS until you process your sequence.

There are some third-party applications available on the Internet that can read the properties of high-resolution files (i.e. DPX, R3D, TIF) to give you the exact dimensions.

5. When you select the format, the frame details are set automatically.

Verify that the Frame Size is showing the correct dimensions. If not, you will need to choose another Format.
6. Select the LUT depending on the delivery format of this sequence.
   For example, if the material you are editing and finishing is for HD Television, then the Sequence LUT will be ITU 601/709.
   
   If you are working with media from only one source and been provided a specific LUT file for this media, you can import it now—see “Importing External LUTs” on page 66.
   
   If you will be using media from different sources, then we recommend that you select the LUT that is most appropriate for the final output.

7. For the Storage Settings:
   - Set the Resolution for capturing/linking video media to Full.
   - Set the Color Space to RGB 4:4:4.
5 Editing Film-based Projects

- Set the Bit Depth to 10-bits. This is typically the format at which film is scanned.

8. Select Use the closest media available, to allow Avid DS to display media of mixed resolutions and frame rates in your sequence.

9. Set the Processing Precision to a bit-depth that will give you the best quality for your processed effects. To preserve the quality of the bit-depth of 10-bit material, choose 16-bits. For more information on bit depth, see “Video Quality” and “Bit Depth” in the Help.

   If you selected the ITU 601/709 LUT, then select the 32 Bits float option for Processing. This ensures that the LUT can be reversed transparently so that you can view your media without your LUT if necessary.

   Although Avid DS can support higher bit depths during processing, the caches may be stored at a lower bit depth depending on your resolution and color space settings. Note that, using a higher precision bit depth generates smoother effects during processing, and still produces better quality output for lower bit depth outputs. Optionally, you could set the Precision bit depth to the same setting as the Storage bit-depth. Then, if you want to process a specific effect at a higher-quality bit depth, you can change the Precision bit depth within the Processing dialog box, or in the Options property page of the effect.

10. For the Audio Settings, set the Sample Rate and Bit Depth at which you will output your audio media.

11. Leave the conversion settings at default.

12. Click OK to save project preferences.

   Avid DS displays the timeline where you can now begin working on a sequence.

   A project folder is created under the location specified earlier. This is where all your sequences will reside.

Conforming a Film Sequence using an AFE

AFE (Avid File Exchange) files are an efficient way to transfer projects and bins from an offline to an Avid DS online finishing system. AFE files let you transfer one or more bins, their contents, and information about the contents, including master clips, subclips, titles, and sequences.
Conforming a Film Sequence using an AFE

To load the AFE:

1. From your offline editing system, take the AFE and other project files that you may require (e.g. EDL, ALE) for the sequence that you are conforming, and copy them to the local project folder that was established when you created your project in Avid DS.
   e.g. C:\DS Projects\DS v.x\Casino\...

2. In Avid DS, navigate to this folder and double-click the AFE.
   The loaded bin displays in the lower area of the screen.

3. When conforming R3D files, it is recommended that you log them by deselecting Create Linked Clips for File Sources. You can then capture the R3D media either from the Avid Explorer or from the Timeline.

4. Double-click the bin that contains the sequence that you want to conform.
   The contents of the bin are displayed.

5. Select Create Associated clips and Use Alternate Video Sources, and then click Configure.
   The Choose Alternate Video Sources dialog opens so that you can select your DPX or R3D files.

6. Proceed to “Linking to High-Resolution Files during the Conform Session” on page 44.
Conforming a Film Sequence using an EDL

An edit decision list (EDL) is a detailed list of the edits contained in a sequence, including all the timecode and supported effects information required to re-create the sequence in an online videotape suite. Avid DS accommodates EDLs from many different systems.

In a tape-based workflow, you can log the events in the Avid Explorer, and/or recreate the list of events on the timeline. You can then capture the media from either the Avid Explorer or the timeline—see “Batch Capturing” in the Help.

Before conforming your EDL, check if there are any layers to be composited. Offline editors often create multiple EDLs since the EDL format does not support more than one video track.

During the conform process, you can set up the appropriate heads and tails values for each clip. This is important if you need additional material at the beginning and end of each clip to do minor changes during the final stage of the edit. You can also configure the audio channel patching for each tape.

If the proofing session is successful, you can then remove the video track you added and continue to add effects and finishing touches to the original sequence.

To open an EDL:

1. Select View > Single-instance Views > EDL.
2. In the EDL view, click the Load EDL button to load a new EDL.
3. In the Open dialog box, browse to your project folder and select the EDL.
   If you know the system from which the EDL was generated, select the appropriate File Type.
4. Click the Open button.

The selected EDL is displayed in the EDL view. The EDL view lets you import an EDL file produced on any external system, and capture material based on the edits in that EDL. For more information about the EDL view, click the Help button.

5. Click the Conform EDL button.

If you selected the wrong file type, you are prompted to convert the file to the appropriate type.
6. In the EDL Conform dialog box, select whether you want to create Logs and/or Timeline Clips.

7. If your digital master is in DPX or R3D file format, select Use Alternate Video Sources and click Configure.

Proceed to “Linking to High-Resolution Files during the Conform Session” on page 44.

**Linking to High-Resolution Files**

By creating links to media files that are not stored on a remote storage device, you can work with media files without having to capture them to your local storage. These files, called *linked clips*, can reside anywhere on the network until you’re ready to output your sequence.

Some projects may require you to work with images at varying resolutions (sizes). When you capture these files, you must convert the material to the working resolution of the current sequence. By linking to the material instead, you can keep the material at its original resolution regardless of the sequence’s frame size. Once you have completed your edits, you can process the linked material, which creates a cache file of the image area that is visible in the viewer.
Linking clips is also useful when more than one person needs access to the same file. You can capture the file as a linked clip, drop it into your sequence, and continue to use it as a reference while another person continues to work on the source media file. Changes made to the original file automatically appear in the linked clip, both in the Avid Explorer and on the timeline. You can also use the Copy-Link function to make a copy of the original media and then link to it—see “Copying and Linking Media” in the Help.

If another person tries to modify a file that is linked to a clip in an open project, they will not be able to save that file due to a sharing violation. You must close the project that contains the linked clip for them to be able to save the original file.

Once you are ready to output the sequence, simply process the clip on the timeline. If you process the material, a cache file is created. Once a cache is created, Avid DS no longer refers to the source media file, but uses this cache file during playback. Any further changes to the source file do not appear in the linked clip on the timeline. Like any other cache however, the cache for the linked clip can be purged, which relinks the clip to the source file.

If the original file is removed from its location, you will receive a “Media not available” message when you playback the portion of the sequence that uses that clip.

- If you are conforming a sequence—see “Linking to High-Resolution Files during the Conform Session” on page 44.
- If you are building a new sequence in Avid DS—see “Creating Linked Clips” on page 43.

Creating Linked Clips

When you link to media on your storage, linked clips will appear in the Avid Explorer similar to master clips. Since no actual media has been captured, their file type icons will be underlined in red.

Depending on the type of media you are linking to, your system hardware, or the storage where your media resides, some linked clips do not require processing and can be played back in real time (such as .gen, .omfi, .mxf, .dp, or .cin files). If you cannot view your media in realtime when they are placed on the timeline, you will need to process. Processing the clips will create media caches on your storage which will be used instead of the original linked media.

If the Media Not Found message appears in the viewer when using linked clips, it is possible that the file has been moved or that Avid DS has lost the connection to the linked file. To re-establish the link, see “Relinking a Clip” in the Help.
To create a linked clip:

1. In the Avid Explorer, open a bin and select the file(s) you want to capture as linked clips. To select a series of files, click the first file, hold down the Shift key, and click the last file. To select multiple files, hold down the Ctrl key and click each file name.

   *If you select a sequential list of still files of the same type (such as all .DPX or all .TIF), you will be asked if you want to combine the files into one master clip or capture individual clips. Working with one master clip makes editing much easier.*

2. Right-click a file and select Capture Settings.

   The Capture Settings dialog box opens.

3. Select the settings that apply to the files that you want to capture. See “Capturing Material from File” in the Help.

   *Since linked files are brought into Avid DS at their original resolutions, there is no need to convert them to the current sequence’s resolution. As a result, the Media Conversion modes are not applicable when the Link option is selected.*

4. Close the Capture Settings dialog box.

5. Right-click the selected files and select Link.

   An Import dialog box opens and the first file (first frame of the transfer) is displayed in the viewer. For more information on the options in this dialog box, click Help.

6. Optional. If you are working with film-based material, make sure you select the appropriate LUT for your footage. By default, Avid DS selects an appropriate LUT for the file type you are working with. However, if you have a LUT that was provided together with your footage, then you should use this LUT instead.

7. Click Ok to begin the import.

   As the material is linked, clips appear in the selected bin. The clip icons are underlined in red to indicate that they are linked clips. Although no media has actually been captured, when they are placed on the timeline, the media will still be referenced.

   *You can view additional information about the linked clip by right-clicking on the clip, and selecting Clip properties. On the Format Specific tab, click the File Info button.*

### Linking to High-Resolution Files during the Conform Session

Once you have opened your AFE or EDL, you can select the DPX or R3D files that you need to use for the sequence you are conforming.

If you have a folder containing different media types, Avid DS will ask you which type of media you want to use for the current conform.
If your sequence contains several types of media, you will have to conform it once per type of media, and replace them manually on the final sequence.

To find the DPX or R3D files:

1. In the Choose Alternate Video Sources dialog, select Quick browse.

2. Click Select Root Folder and browse to the folder where the files are located on your video storage.

3. Select the folder that needs to be scanned and click Select.

   All subfolders under your selected folder will also be scanned.

4. (Optional) When working with DPX files that do not contain the timecode information, then you will also need the ALE (either from the film house, MetaFuze or Avid Media Composer) to make the necessary correspondence to the associated DPX files.

   Click Select ALE File, and browse to the folder where the ALE file is located.

5. Click Scan.

   The folder is scanned, collecting the metadata that it contains, to display the timecode and/or KeyKode associated to each file referenced in the EDL/AFE.
5 Editing Film-based Projects

When linking to DPX files via an ALE, Avid DS retrieves the metadata in the DPX files (i.e. timecode, KeyKode, tapename) and uses the ALE to make the relationship between the corresponding AFE/EDL timecode/KeyKode edits. As a result, the following situations may occur:

- The DPX files contain the tape source information (i.e. tape name and timecode). In this case a direct association can be made between the DPX file’s timecodes/tapenames, and the edited sequence’s timecodes/tapenames.

- The DPX files only contain film source info (i.e. KeyKode). In this case, you must also specify an ALE file to allow Avid DS to create the association between the DPX file’s KeyKode, and the edited sequence’s timecodes/tapenames.

- The DPX files only contain timecodes. In this case, the folder in which the DPX file is located is used as the EDL/AFE “tape name”.

6. Click OK.

An Import dialog box opens and the first file (first frame of the transfer) is displayed in the viewer. For more information on the options in this dialog box, click Help.

7. Proceed to one of the sections below depending on whether you conformed from an ALE or EDL:

   ▶ “If you conformed from an AFE:” on page 46
   ▶ “If you conformed from an EDL:” on page 47

If you conformed from an AFE:

1. After all files are successfully scanned and linked, open the bin file in the AFE view.
2. Select a sequence and drop it onto the timeline.
3. Copy the master clips to your project folder.

The linked clips will be indicated in the Avid DS Explorer with a red underline.
Linked files will be real-time for DPX formats if:
- The resolution of the DPX files is supported for realtime playback on your system configuration—see the Avid DS support website at www.avid.com.
- The DPX files are on your local videostorage that is large and fast enough to support high throughput.
- The format of the DPX files exactly match the format of the current sequence.
- The current sequence storage bit-depth is set to 10.
- The data in the DPX files are correctly aligned. This should almost always be the case. If not, the FixDPX utility can fix any misaligned data DPX files—see “Aligning your DPX Files” on page 47.

If you conformed from an EDL:
- In the EDL Conform dialog, click the Conform button.

The log/linked clips are created for the DPX files.

Audio is ignored when conforming DPX files. You will need to import the audio separately.

Aligning your DPX Files

If Avid DS gives you a message that your DPX files cannot be read, it may be due to misaligned sectors in the DPX files. This can easily be realigned using the FixDPX utility.
5 Editing Film-based Projects

To align your DPX files:

1. If the sequence using the DPX files is currently open, exit Avid DS, or switch to another project.
2. Click the Start button and select Programs > Avid Products > Avid DS > Tools > FixDPX.
3. In the FixDPX dialog, click the File... button to browse for a specific file that you want to fix.
   If you want to fix several files, then click the Folder... button to select the folder name.
4. Click Fix it! to begin.
   The FixDPX utility will display a summary of the files that were or were not fixed.
5. Click Done to exit.

Capturing High Resolution Media from Tape

HDCAM-SR is commonly used for HDTV television production. However, HD resolutions are now also used more and more for film work, especially in 4:4:4 RGB color space. The 4:4:4 refers to an encoding technique that holds onto all of the image's red, green, and blue color data for superior color fidelity, unlike the traditional 4:2:2 YUV mode, which discards half of the color data. Although this method does not support resolutions as high as film-scanned DPX files (2K, 4K), HDCAM-SR does allow for fairly high quality resolution (upto 1920 x 1080 HD), and with the latest digital film cameras, material can also be shot directly in RGB 4:4:4. Also, Telecines now perform high-quality transfer directly to HD in real-time, which is much faster and economical than a typical film scanner.

To ensure the highest quality of the master tape, transfer your film reel to HD format in 4:4:4, which offers the best uncompressed color quality currently available on video. The film should also be transferred as 16:9 so that the conform process will not only be frame-accurate, but also pixel-accurate in the sense that the effects will match the same aspect ratio (titles, shapes, etc.).

When working in HD, you can capture all the media and edit directly in Avid DS—see “Logging and Capturing Clips from Tape” on page 49.

Alternatively, you can do your offline editing in Avid Media Composer, and conform and finish your project in Avid DS. For this workflow, see “Conforming HD Video Sequences” in the Help.
Logging and Capturing Clips from Tape

When capturing from tape you have the choice of capturing media as you preview the tape, or logging the in and out points to create empty master clips that can be captured at a later time.

To log and capture clips from a tape:

1. Do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the NLE toolbar just above the timeline</td>
<td>Click the Media IO button and select Capture Tool.</td>
</tr>
<tr>
<td>From the main menu</td>
<td>Select View &gt; Single-Instance Views &gt; Capture Tool.</td>
</tr>
</tbody>
</table>

2. Configure the external device, specify the capture quality, and other perform other tasks listed in “Preparing to Capture Material” in the Help.

3. Click the Tape button.

4. Click the Log/Capture mode button. It toggles between the following modes:

<table>
<thead>
<tr>
<th>Button Mode</th>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capture clips</td>
<td>Set the Capture mode and specify the exact in-points and out-points. When you click the Capture button, the deck will roll and the capture the media between the selected in and out-points.</td>
<td></td>
</tr>
<tr>
<td>Log clips</td>
<td>Set the Log mode and specify the exact in-points and out-points. When you click the Capture button, an empty master clip will be logged in your bin.</td>
<td></td>
</tr>
</tbody>
</table>

5. From the Deck list, select a deck preset.

6. (Optional) Set a custom Preroll for the deck.

   This setting temporarily overrides the setting in the deck template but does not change it.

7. Click the Check button.

   If the communication between the external device and your system is operating properly, nothing happens. If there is a problem, a message box appears, stating the possible cause of the problem.
5 Editing Film-based Projects

You can verify that the external device is operating within normal parameters by checking the five items in the External Device Status area, located beneath the transport controls. See “Transport Controls” in the Help.

8. From the source name list, select the tape’s name.
   
   If the tape is new, click the New Tape button and enter a name for the tape. The tape name is added to the Tape Library. See “Managing Tapes” in the Help.

   It is very important to assign a unique name to every tape because Avid DS uses it to identify the captured media.

9. In the Clip Name text box, enter a name to prefix all captured clips.

10. From the Target list, select a location to hold the clips.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Root</td>
<td>Creates master clips in the folder with the project name (the project folder).</td>
</tr>
<tr>
<td>Main Explorer Location</td>
<td>Creates master clips in a bin you selected in the Avid Explorer.</td>
</tr>
<tr>
<td>Auto-Source</td>
<td>Creates master clips in a folder with the same name as the tape name.</td>
</tr>
</tbody>
</table>

The most recently activated bin within the project root becomes the capture target. An icon in the title bar marks a bin as the Capture Target.

You cannot create master clips outside the current project. Avid DS checks the path to make sure the folder is within the project folder.

11. If you are working with logarithmic media (such as film-based material), you will need to select a LUT in order to linearize your media for Avid DS. The LUT is used to preserve the color data of the material when it is captured into Avid DS.

   Typically, you need to apply a LUT that corresponds to the camera that shot the footage.

   If you do not have details on which camera was used, then the sequence LUT (selected when you opened your project/sequence), will be used by default.

12. To select a different LUT when capturing your media, select User Defined LUT from the LUT drop-down list.

13. Click the LUT button.

   The RGB LUT dialog box opens. For descriptions of the parameters in this dialog box, see “RGB LUT” in the Help.
14. Select or customize the LUT by doing one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose a predefined LUT.</td>
<td>Select the appropriate LUT from the drop-down list. For HD RGB 4:4:4 sequences, you can use the ITU 601/709 LUT.</td>
</tr>
<tr>
<td>Choose a standard camera LUT or create a custom LUT.</td>
<td>Select From File from the LUT Creation drop-down list, and click the Create LUT button. Browse to the /DS_v10.x/Luts/Lut presets folder and select the appropriate camera LUT—see “Industry LUT Presents Available in Avid DS” in the Help.</td>
</tr>
</tbody>
</table>

15. Click OK to save your settings and close the RGB LUT dialog box.

16. Click the Timeline/Deck Control button to set it to operate the Deck controls. It toggles between Timeline and Deck mode.

17. Click the Video button to capture the video channel of the material.

18. Click the Audio button to capture one or more audio channels of the material.

19. To record additional material before the in-point and after the out-point, type the appropriate number of frames in the Heads and Tails text boxes.

20. Use the transport controls to play or shuttle the tape to the point where you want to start the capture and click the Mark In button.

   The timecode of the in-point you selected is displayed in the In timecode box.

21. Play or shuttle the tape to advance to the point where you want to end the capture and click the Mark Out button.

   The out-point is displayed in the Out timecode box. The Duration timecode box displays the length of material to be captured.
5 Editing Film-based Projects

**Tip:** If you already know the in and out timecodes, you can type them directly in the In or Out timecode boxes. You can also enter a value for the duration and Avid DS will calculate the out-point.

You can use the numeric keypad to enter in-points and out-points. Begin typing the timecode and an entry box is displayed. When you finish typing, press the I key to set an in-point or the O key to set an out-point. Or type a duration and press the D key. To go to a particular location on the tape, type the timecode and press Enter.

22. You can add locators with comments while capturing. See “Adding Locators White Capture” in the Help.

23. Click the Start/Stop Capture button.

As the material is logged, or logged and captured, clips appear in the Avid Explorer according to the in and out points that you specified.

Logged video clips appear with an image of the Avid DS clapboard icon, since they do not have any media. Both video and audio clip icons are also red to show that no media has been captured. You can later capture these clips in one batch directly from the Avid Explorer.

While capturing you can add locators that will be linked to a specific timecode. See “Adding Locators White Capturing” in the Help.
If Avid DS is unable to capture the material on the first attempt, it will try again. If it fails again, Avid DS will attempt the capture a third time with an additional preroll of five seconds. If the capture fails again, an error message is displayed with a possible explanation for the problem.

If you encounter problems capturing material from tape, you should deactivate the viewer using the Viewer button in the status bar and try capturing again. When capturing full resolution HD material at 29.97 and 30 frames per second, the viewer is automatically deactivated.

If any frames are skipped during the capture, the capture stops, and an error message is displayed. Clips are created for the material that was captured up to the point at which frames were dropped.

If Avid DS detects any problems during capture, the Capture Error Log is displayed. The Capture Error Log dialog box displays the clip that could not be captured, including tape source name, in-point, and out-point. It also gives you a brief description of the type of error that occurred.

a. To save this log as an .html file, click the Save As button.

b. In the Save As dialog box, navigate to an appropriate folder, type a name for the log and click the Save button.

The log is saved as an .html file and can be viewed in any HTML browser.

Avid DS stops a capture session if it detects any timecode breaks on the source tape. It creates a master clip from the in-point to the timecode break. The capture session may stop a frame or two after the actual timecode break. If this happens, you may have to cut or trim some of the unusable frames from your clip.

To resume capture, enter new in and out-points in the In/Out timecode boxes and click the Start/Stop Capture button.

If there is insufficient material for the deck to preroll before capturing, you will not be able to capture the material. In this case, use the Live capture option to capture the material.

Capturing Film-based Media from File

You can capture digital film types such as DPX and R3D files.

If the series of digital files were provided by a film scanning facility, use the accompanying LUT file that was applied during the transfer as the Masterclip LUT.
5 Editing Film-based Projects

When capturing this media, you will need to use the LUT from the digital film camera or one that was provided to you from the film transfer facility. This LUT known as the Masterclip LUT, needs to be imported when you set the capture settings. If you do not have a masterclip LUT, the sequence LUT that you selected when you opened your project/sequence will be used by default.

**To capture film-based media from file:**

1. Right-click the file(s) that want to capture and select Capture Settings.
2. Set the appropriate options—see “Video Capture Settings” in the Help.
3. Right-click the file(s) and select Capture.
   
   The dialog box that opens depends on the type of file that you are capturing.
   
   - DPX files—see “DPX Import Dialog Box” in the Help.
   - R3D files—see “RED Import Dialog Box” in the Help.
4. Set your masterclip LUT by doing one of the following:
   
   - Click OK.
   
   As the material is captured, the clips appear in the target bin.

   **To import a LUT that was provided with your media**

   See “Importing External LUTs” on page 66.

   **To use a industry-standard LUT provided by Avid DS**

   Select the appropriate LUT from the drop-down list. For DPX, you can use the ITU 601/709 LUT. For R3D, you can use the RED LOG LUT.

   **Choose a standard camera LUT or create a custom LUT.**

   Select From File from the LUT Creation drop-down list, and click the Create LUT button. Browse to the `/DS_v10.x/Luts/Lut_presets` folder and select the appropriate camera LUT—see “Industry LUT Persets Available in Avid DS” in the Help.

5. Click OK.

   As the material is captured, the clips appear in the target bin.
Viewing High-Resolution Sequences

Avid DS allows you to playback SD and HD sequences in realtime in the Avid DS viewer or on an external monitor. When working with sequences that are higher than HD resolution, your system may not have sufficient bandwidth to output to an external monitor. In such a case, you have two options:

- Use the Realtime Proxy mode: Avid DS converts the sequence format to a lower-sized HD resolution that still provides excellent visual quality for editing and previewing your sequence in a video monitor. For more details, see “Film Proxy Mode” on page 57.

- Use the Graphics-link mode: You can redirect your output through the graphics card to a second monitor. Even with high-resolution 2K sequences, Avid DS is capable of 10-bit 4:4:4 RGB color-managed display on either a computer monitor, or an external monitor. Only NVIDIA graphics cards with sufficient memory support this mode. For details on which cards are supported, see the Avid DS support website at www.avid.com.

Using Avid DS Graphics-Link with an External Monitor

If your Avid DS system is equipped with an appropriate NVIDIA graphics cards (Quadro FX-4600, FX-4800, or FX-5600) you will be given the option to play back high-resolution sequences (HD or higher) on an external monitor. Using the GPU processor and the second output of the graphics card, Avid DS is capable of 10-bit 4:4:4 RGB color-managed display on either a computer monitor, or an external monitor such as DreamColor, Cine-tal or Barco.

To use the graphics card for output, you need to use Avid DS Graphics-Link (This option is available via an icon on your desktop). Avid DS Dual-Link and Avid DS Graphics-Link cannot be run at the same time. To change between these different modes, Avid DS must be closed and re-opened in the desired mode of operation.

To use the Avid DS Graphics-Link option:

1. Save your sequence and close Avid DS Dual-Link.
2. Open Avid DS (Graphics-Link) from the desktop.

While using Avid DS in the Graphics-Link (GL) mode, the dual-link card will still be used for audio playback, but all forms of capture will be disabled (even if the capture tool is available).

When viewing images on the external monitor, the sequence format is always maintained, regardless of the size of the connected monitor. Therefore, if the resolution of your monitor is smaller than the sequence resolution, the output will be reformatted.
5 Editing Film-based Projects

in real time to fit the monitor’s aspect ratio. The output settings can be changed via the Sequence Preferences dialog with the choice of None (Centers the image), 1080p padding (pad around the sides), or 1080p CenterCrop (do a center crop).

If your workstation has the supported hardware, sufficient memory and processing power, you may be able to view your high-resolution sequences in realtime.

You can also analyse the pixels in your image using the waveform monitor and histogram options on the external monitor view using the GL mode.

To display the waveform monitor or histogram on the external monitor:

1. Move your mouse over to the external monitor view and click on it.

This viewer is now in focus and you can use the following keys on the main area of the keyboard:

<table>
<thead>
<tr>
<th>To</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/disable the waveform monitor</td>
<td>S</td>
</tr>
<tr>
<td>Show RGB value of each pixel</td>
<td>X (for row) C (for column)</td>
</tr>
</tbody>
</table>

When viewing colors in the waveform monitor, use the mouse to point to the area of the image that you want to analyse. The coordinates of the pixel and the RGB values will be displayed in the bottom left corner [x, y, R, G, B].

Enable/disable the Histogram | H
View a histogram of individual Red, Green or Blue channel | R, G or B

When viewing colors in the histogram, the black and white level limits are set according to the sequence format. These are indicated by the two vertical lines on the left and right of your screen. The minimum and maximum range values are also indicated next to these lines.

Change color of the lines in the histogram display | [ or ]
Lighten or darken the lines in the waveform monitor/histogram display | + or -

2. To return the focus to your Avid DS Viewer on the primary monitor, move your mouse over to the viewer and click on it.
Film Proxy Mode

When editing high-resolution sequences (higher than HD), you have a choice of displaying and processing either in full resolution or real-time proxy resolution. The proxy is a lower-sized HD resolution that provides excellent visual quality for editing and previewing your sequence in a video monitor.

With proxy resolution, the correct aspect ratio is preserved in the Avid DS viewer as well as in the external HD monitor. Even an SD monitor can be used when working with 23.97, 29.97 and 25-fps sequences. In addition, color space is automatically taken into account by Avid DS to make the use of these proxies as transparent as possible.

*When working in full resolution, the results of the processing can only be seen in the Avid DS viewer, as the external monitor is disabled. If your system has a graphics card that supports high-resolution formats, you can redirect your output to the external monitor—see “Using Avid DS Graphics-Link with an External Monitor” on page 55.*

To work more quickly and efficiently, you can apply effects in the lower, real-time proxy resolution. In this mode, real-time effects do not need to be processed. If any effects do require processing, the resulting caches are also generated in real-time proxy resolution to save disk space.

*If any effects were previously processed in full resolution, then Avid DS will use these caches instead of the proxy 4:2:2 caches.*

When you are ready to output your final sequence, you can switch back to full resolution to process your effects. Processing in full resolution has the advantage of highly accurate processing using 4:4:4 RGB values.

When working in film proxy mode, note the following:

- You can work in either RGB 4:4:4 or YUV 4:2:2 proxy modes. If you are applying effects that modify color and you are outputting to RGB 4:4:4, then set the Resolution to 4:4:4.
- Proxy modes are determined by the type of sequence in which you are working. For example, when working with R3D files, the RGB 4:4:4 film proxy mode is used.
- You cannot enable viewer LUTs in YUV 4:2:2. However, you can use the LUTs effects on the Timeline as an effect. Do note that if you are using it to make color modifications, it is a good idea to work in a 4:4:4 proxy mode for an accurate color display.
- When in a shared collaborative environment using an Avid Unity, the Avid DNxHD proxies can easily be shared between Avid Media Composer HD and Avid DS systems. Avid DNxHD compression ratios are also available to you when you use proxy mode. For a description of these ratios—see “Avid DNxHD Compressions” in the Help.
5 Editing Film-based Projects

Enabling Film Proxy Mode

Real-time proxy mode is only available on an Avid DS workstation that has the appropriate hardware. Otherwise, you can work in Full resolution which still gives you real-time playback of your media in the viewer, but not the external monitor.

To set your sequence preferences to work in proxy mode:
1. Select File > Sequence Preferences.
2. Set the Resolution to Real-time Proxy so that you can edit and add effects in real-time.
3. On Avid DS workstation, you can change the Compression to one of the Avid DNxHD compression formats.
   This will save you space on your storage device while you are editing your sequence.
4. Set Downconversion of HD/SD output to the appropriate setting so that you can feed your output to an external monitor and view the results.
   In the Avid DS viewer, the real-time proxy mode compensates for change in aspect ratio. For the external monitor output, you have the flexibility to either see a cropped version of the frames, or a centered and padded version. Internally, Avid DS still holds the entire frame.
5. Click OK to set the preferences.

Editing and Applying Effects in Film Proxy Mode

To work more quickly and efficiently, you can apply effects in the lower, real-time proxy resolution without having to process real-time effects do not need to be processed. If any effects do require processing, the resulting caches are also generated in real-time proxy resolution to save disk space. If any effects were previously processed in full resolution before the switch to the proxy mode, Avid DS will use these caches.

When you are ready to output your final sequence, you can switch back to full resolution to process your effects.

To edit and apply effects in proxy mode:
1. Load your sequence or clips onto the timeline.

   If you cannot get realtime playback for your media, you can process your timeline. This generates media on your local storage based on the format of your sequence.

2. Perform the necessary edits, color correction, and addition of effects to your sequence.
   While applying effects such as Keyers or creating mattes, toggle between Proxy and full resolution modes by clicking the button with the green dot above the viewer.
3. If are applying a LUTs effect on the Timeline—see “Applying a LUT Effect” on page 68.

4. Switch back to full resolution mode and process the effects—see “Processing Effects” in the Help.

5. When ready to output, see “Outputting Film Sequences” on page 59.

Outputting Film Sequences

Avid DS supports output mastering of film-based projects to any of the original transfer formats.

You can output the film sequence to tape or to a digital file format such as Cineon or DPX. The delivery depends on how the output will be displayed. For example, for HD TV broadcast, you should output the final sequence to tape.

By default, the Sequence LUT is used when outputting to tape or to file. This ensures that the color information used when editing and applying effects in your sequence remains the same during output.

Outputting to Multiple Formats

Outputting your sequence to multiple formats is known as Universal Mastering. If you are working in an HD sequence, you can easily deliver the same sequence to multiple formats such as film or NTSC formats. In the case of a film output, it is possible to output a final series of film-resolution images (2-4 K) for a film recorder.

To deliver to multiple formats:

1. Save the sequence after you are finished editing and applying special effects.
2. Create a new sequence making sure that you are using the same frame rate as the sequence you just saved.
3. In Avid DS, select the sequence and drag it on the timeline.
4. Output the sequence using the applicable settings.

Outputting DPX Files

In the case of a film output, it is possible to output a final series of DPX images for film recorder compatibility. All color information from the sequence LUT is also encoded within the DPX files.
5 Editing Film-based Projects

To output a sequence to DPX or Cineon files:


2. Select the material to output. You can choose the entire timeline or specific in/out timecodes.

3. Click the To File button.

4. For File Type, select the file format which you want to export (DPX or Cineon).

   The DPX Export dialog box opens.

5. For the LUT, Avid DS will use the Sequence LUT that was set when the sequence was created. You may change this if necessary.

6. If you want to save a timecode on each frame in the file, select Export Timecode, and set the appropriate timecode start time.

   ![DPX Export dialog box]

7. Click OK to save the settings.

8. In the Output Tool window, keep the Output Resolution at the defaults.

9. For the Output Options, select the appropriate Codec (if applicable).
10. Select the Preserve Alpha option if the sequence includes an alpha channel that you want to keep in the output file.

This is useful if you plan to reuse the matte information in future compositing or graphics projects. However, not all file formats support alpha channels.

11. To resize your file, select Use Advanced Settings.

Click the Help button for more information on the parameters in this dialog.

12. Click the Output button to begin the export.

13. Select a folder in which to save your material, enter a name for the file, and click Save.

The material is processed, if necessary, exported to file, and placed in the selected folder.

14. Close the Output Tool dialog box.

**Outputting to Tape**

When you output to tape, the image size must match the resolution set in your Sequence Preferences.

**To output to tape:**

1. Do one of the following:
   - From the NLE Tools toolbar above the timeline, click the Media IO button and select Output Tool.
   - Select View > Single-Instance Views > Output Tool.

The Output Tool opens.
For information about options in the Output Tool, click Help.

2. Configure the external device and perform other necessary pre-output tasks. See “Preparing for Output” in the Help.

3. Click the To Tape button.

4. Select the Deck.

   The device that is currently active will display in the Deck list. You can select an another device preset from the list.

5. Click the Check button.

   If the link between the external device and your system is operating properly, nothing occurs. If there is a problem, a message box appears, stating the possible cause of the problem.

   You can also verify that the external device is operating within normal parameters by checking the five items in the External Device Status area, located beneath the transport controls. A green or red light beside each item displays its status. Items that are grayed out are inactive.

6. Select the Edit Mode, either Auto (Insert) or Assemble.

   This setting temporarily overrides the setting in the deck template but does not change it. For more information about Edit Mode, see “Configuring the External Device for Output” in the Help.
7. (Optional) Set a custom preroll for the deck.
   This setting also temporarily overrides the setting in the deck template but does not change it.

8. Make sure the Timeline/Deck button is set to Deck.

9. Click the track buttons (V, A1, A2, and so on) for the video and audio tracks you want to output.

10. If you are experiencing any frame delays in audio when you output your sequence to tape, enter the number of frames in the Audio Propagation Delay text box.

11. If you need to output your sequence to a lower resolution format than the current sequence setting, click the Convert button.
   Select the required output formats. The options that are available depend on the current video format. For a list of the available formats, see “Downconverted Output Formats and Sync Sources” in the Help.

12. If you have not selected the Use Timeline Timecodes for Edits option, specify the position on the tape where you want the program to start recording. Use the transport controls to locate the position or type a timecode in the I (In) field. See “Selecting an area to Output” in the Help.

   If you are insert editing your material, your tape must be properly striped with timecode before attempting to output your material.

13. (Optional) Click the Preview button to view your sequence before outputting to tape.

14. Click the Insert button. If you set the Edit mode to Assemble, then click the Assemble button.
   The selected media in your sequence is output to tape.
5 Editing Film-based Projects
6 Using Lookup Tables

A Lookup Table (LUT) is used to map input color values to output color values. A full description of LUTs and how they are used in the Avid DS color management pipeline is provided in “Color Management” on page 9.

Customizing LUTs

When you start a new sequence, it is recommended that you customize LUT files only when you need to change the Black and White points, the Gamma, and the Black and White gain values of the media. It is crucial that you understand these properties and their relationship to each other.

Example: If you are using the ITU 601/709 LUT, Avid DS maps the color values of 64 in 10-bit to black. If you want to use a color value of 67 as black, then you can nudge the value to 67 to make sure that black is properly represented.

Note the following:

- By default, R, G, and B values are locked.
- For a Linear LUT, you can adjust only the White Point and the Black Point. For a Log LUT, you can also adjust Gamma, Film Gamma, and Softclip.

To customize a LUT:

1. In the Video Settings section of the New Sequence Dialog box, select User Defined for the LUT option.
2. Click the LUT button.
   The RGB LUT dialog box displays.
3. From the LUT Creation drop-down list, select the appropriate conversion format.
4. Click the Create LUT button.
   A new LUT is created and is displayed in the Select LUT list. It is symbolized by the asterisk until the page is closed at which point they get saved and the asterisk no longer displays.

5. Edit the values as necessary.
   For descriptions of the parameters in this dialog box, see “RGB LUT” in the Help.

6. Click OK to save the settings.
   The LUT is listed in the LUT drop down list in the Video Settings box.

7. Proceed to set up the new project or sequence.

**Importing External LUTs**

You can import a LUT file that has been supplied for use specifically with the media you are working with in Avid DS. A LUT file can be provided by the camera operator, the director of photography, the film scanning facility, or even a colorist.
When importing R3D files, you can load an RLX file that is generated at the time of acquisition to provide additional color information of the footage.

To select an external LUT file:
1. Depending on whether you are starting a new project or capturing a file, do one of the following:

<table>
<thead>
<tr>
<th>If you are...</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opening a new project or sequence</td>
<td>In the Video Settings section, select User Defined for the LUT option. Click the LUT button</td>
</tr>
<tr>
<td>Capturing a file</td>
<td>From the LUT Creation drop-down list, select From File. Click the Create LUT button.</td>
</tr>
</tbody>
</table>

2. Navigate to the location of the LUT file.
3. Select the file and click OK.

The LUT file is displayed in Select LUT list. The asterisk indicates that it is a new file and will disappear after the dialog box is closed.

---

**Saving and Exporting a LUT File**

You can save and export the LUT file that you have applied during your work. This LUT file can be saved or sent to another editor or colorist who is working on the same footage.

**To export a LUT:**
1. Make sure you are either in the New Project or the New Sequence dialog box.
2. In the Video Settings section, select User Defined for the LUT option.
3. Click the LUT button.
4. In the RGB LUT window, click Export LUT.
5. Navigate to the location where you want to save the LUT.
6. Enter a name for the file and click Save.

Two files are saved: The *.lut file, which is used for the Log to Lin conversion and the *_inv.lut, which is the inverse LUT that can be used for the Lin to Log conversion.
Using Lookup Tables

Enabling a LUT to the Avid DS Viewer

If you are using an external broadcast monitor to view the final output of your sequence, it will display colors that are determined by the Sequence LUT, the LUT file that was set when you started the sequence. You can apply a LUT on the Avid DS viewer for viewing purposes. For example, if the Sequence LUT is Printing Density, the image on the Avid DS viewer may look dull with little or no contrast. You can apply a LUT to view the clips in the color space used by the monitor (sRGB or ITU-601/709).

If you are unsure of which LUT to use, it is recommended that you use the sRGB LUT as this is the color space that is used by the Avid DS viewers and monitors. You can also use the ITU-601/709 as its values are close to sRGB. If you are working in a 4:4:4 sequence, the sRGB LUT is enabled by default.

The viewer LUT does not encode or affect the final output.

To apply a viewer LUT:

1. Make sure that the position indicator is placed on the correct clip on the timeline, right-click the viewer and select Viewer Properties.
2. Right-click the viewer and select Viewer Properties.
   The Viewer Properties property editor displays.
3. In the Display tab, click the Viewer LUT button.
   The RGB LUT dialog box displays.
4. Select the LUT that you want to use to view the clip.

To disable the viewer LUT:

1. Make sure that the position indicator is placed on the correct clip on the timeline, right-click the viewer and select Viewer Properties.
2. Right-click the viewer and select Viewer Properties.
   The Viewer Properties property editor displays.
3. Select Disable Viewer LUT.

Applying a LUT Effect

The LUT and 3D LUT effects are available from the Avid DS Image Effects Library. You can apply these effects for artistic purposes in order to achieve a certain look and feel to a scene. The 3D LUT is specifically applied to simulate film emulsion properties.

They can be applied to clips, tracks, or the timeline.
Applying a LUT Effect

To apply the effect to | Refer to
---|---
Clip | “Applying Effects to Clips” in the Help.
Track | “Applying Effects to Tracks” in the Help.
Timeline | “Applying Effects to the Timeline Effect Track” in the Help.

To select a 3D LUT Effect:

1. In the Avid Explorer, navigate to the Image Effects folder and locate the LUT Effect.
2. Drag the effect to the clip, track, or the Effects tree which you want to apply the effect.
   The effect is applied and the Luts Effects property editor opens.
3. Click the Lin2Log tab and click Enable the selection of the LUT.
4. From the Select LUT drop-down list, select the appropriate LUT that will be used to feed the 3D LUT with the correct log data.
   It is recommended that you select the same LUT that you used when capturing media.
5. Optional: Select Show Input Histogram to view the change in the histogram when the 3D LUT is imported and loaded.
6. Click the 3D LUT property page.
7. Select Enable.
Using Lookup Tables

8. Click the Import 3D LUT button.
9. Navigate to the location of the 3D LUT and click Open to load the table.
   The table is loaded and the histogram will change accordingly. You can select and
deselect the Show Input Histogram option to view the difference.
10. Go to the Log2Lin tab and select Enable.
11. From the Select LUT drop-down list, select the output LUT.

Generating 3D LUTs

The Avid DS 3D LUT Generator is a tool that lets you easily generate a 3D LUT based on
the color differences between the original image and the newly-created image generated
from a color grading system or an external LUT engine.

Using a Color Grading System
Generating 3D LUTs

Using an External LUT Engine

To generate and load a 3D LUT:
1. Go to Start > All Programs > Avid > Avid DS v10.x > Tools > Avid DS 3D LUT Generator.
2. Click the Generate Image button and navigate to a location to save the image.
3. Select the type of image. It is recommended that you use the .dpx format. Avoid using lossy compression formats such as .jpg.
4. Send the image for processing by an external grading system or LUT engine. Once it’s processed, it can be imported.
5. Launch the Avid DS 3D LUT Generator.
6. Click the Resulting Image button.
7. Select the Size of the LUT. Note that a larger LUT size effect will take a much longer time to process on the Avid DS Timeline, but the results will be more precise.
8. Click the Create 3D LUT button and select a format.
9. Click OK.
6 Using Lookup Tables

You can now view a comparison between the input and resulting image using the newly created 3D LUT.
Using Avid MetaFuze

Avid® Metafuze™ provides a complete offline-to-finish file-based workflow when used in conjunction with Avid Media Composer® and Avid DS. Metafuze allows the generation of MXF media from DPX, R3D, TIF, JPG, AVI and QuickTime files, which can be offlined in Avid Media Composer, conformed for finishing in Avid DS.

Film and High-Resolution Workflows using MetaFuze

Single-frame files generated from digital video cameras, film scanning processes or CGI applications, need to be converted to playable media so that they can be read by an Avid editing application like Avid DS or Avid Media Composer. Avid MetaFuze merges consecutive single-frame files (with metadata contained as part of the format) and raw data files from a digital camera into an MXF file.

Avid MetaFuze supports different files including R3D, DPX, TIF, and JPG. It can also transcode QuickTime and AVI sequences into MXF files.

Any file type supported by Avid DS or third-party parsers can be read by Avid MetaFuze. Still-file parsers can be written for both MetaFuze and Avid DS using the parser SDK which is available as part of the Avid DS SDK.

The illustration below shows a typical example of a file-based workflow for editing film footage on an Avid Media Composer or Avid DS.
Using Avid MetaFuze

This workflow shows you how to carry out editing and finishing on footage that is already in digital file format. High-resolution digital files could originate from digital cameras, film-scanning facilities, or CGI applications. The files include R3D, DPX, or TIF.

**Step 1: Group high-res files into MXF files**

If you want to offline in Avid Media Composer, start by using MetaFuze to convert the DPX/R3D/TIF files into MXF playable media in an HD resolution. Import this MXF into Avid Media Composer for offline editing.

**Step 2: Edit and produce final AFE**

After editing the sequence on a Avid Media Composer, export the sequence as an AFE for the finishing on Avid DS.

When exporting your sequence for conform, there are some details to be considered. We recommend that you read the following whitepapers available on www.avid.com:

- *Using HD-RGB with Film in HD-based DI Workflows*
- *Avid/RED Workflow Guide*

**Step 3: Conform AFE**

On Avid DS, you can conform the AFE and connect to the original DPX/R3D/TIF files.
In the case of DPX files, necessary information such as KeyKode™ (key number) and timecode is inserted as metadata into the DPX file during the scanning process. If the DPX files do not contain the timecode information, the ALE is required in order to make the necessary correspondence to the associated DPX files. The ALE is usually supplied by the film-scanning facility or output by MetaFuze/Avid Media Composer.

The MXF file is not required for the finishing process but it could be imported onto a separate video track in Avid DS and used as part of the conform check process.

Depending on your system configuration, many high-resolution formats are playable in real time—for a specific list of these formats, see the Avid DS support web at www.avid.com. When editing high-resolution projects where real-time playback is not achievable, you can use the proxy mode to apply effects and view the results in HD 4:2:2 or HD 4:4:4.

Step 4: Output to tape or file

You can output the final sequence to master as a series of DPX or Cineon™ images (with an appropriate LUT) for a film recorder. You can also output any other SD or HD formats as required.

Opening a Project in MetaFuze

When you start the MetaFuze application, it automatically opens a new empty project. A project in MetaFuze organizes and displays all the elements that are related to the project such as, source file folders, the groups of files created from scanned folders, and the information required to create MXF media files.

If you are starting a new project, you can proceed to “Scanning your Folders” on page 77.

To open an existing project:
1. Select File > Open Project.
2. Select the name of the project that you want to open.
   The selected project opens and displays the project components.

Customizing the MetaFuze Window

The views and toolbars within MetaFuze can be moved to a different position within the window, or can be “torn off” and dragged outside of the main window.

In addition, the columns in the Groups view can be rearranged or removed as necessary.
To move a view within the main window:

1. Select a view or toolbar that you want to move.
   
   To select a view, click its title bar. To select a toolbar, click the extreme left where you see the vertical dotted line.

2. Drag the view to any position within the window where you would like to place it.
   
   The cursor position determines the destination. If another view exists in that location, it will automatically move over, and a shaded blue area will appear to indicate where your selection can be placed. Release your mouse to drop the selection into place.
Some views can be undocked from the main window by clicking and dragging their title bar outside the main window. Doing this creates a new window that you can stretch out if you need to see the values more clearly. It also allows you more viewing space for the other views in the main window.

The changes that you make to the window display are automatically saved and reloaded each time you open MetaFuze.

To change column headings in the Group view:

- Select a column heading and drag it left or right to a new position. Release your mouse button to drop the selected column into place.
  
  or

- Click the Add/Remove Columns button.
  
  Select/deselect any columns that you want to display, and click OK.

Any changes that you make to the column display can be saved by clicking the Save Preset button. You can save your settings under a new preset file name or modify an existing one.

**Scanning your Folders**

MetaFuze is designed to scan specified folders and create groups of files based on similar file types found in these folders. The scan process groups together any files that have consecutive filenames, key numbers, or timecodes. The image resolution (same width and height), is also taken into account.

Once the groups have been formed, they can be selected for transcoding.

**To scan your folders:**

1. Select Actions > Scan Folders.
2. Browse to the folder where your files are located.
   
   The folders can be on your local workstation or on remote storage. (To locate folders on a remote storage, you might need to use the full pathname, for example, \\
   \<machine_name>\<folder_name>.)

3. In the list of available folders, select a folder name, and click the Add Folder button to add the folder to the Selected paths list.
4. Select and add as many folders as you want.
5. Option. You can reorder the selected paths using the Up and Down Arrow keys.
6. Option. To remove a folder from the list of selected paths, select the path and click the X button.
7. Click the Options button, and specify the criteria by which you want to group your scanned files—see “Scan Folders Dialog Box” on page 97.
8. By default, the Filename is always considered as one of the criteria. Select the Timecode and/or Key number options if you’d like to use this data as well.
9. You can change the priority order of the criteria by clicking the Up or Down Arrow keys.
10. If you want to specify the type of files to search for, then click the File Types button. Select only the file types that you need. This filters out any unwanted file types and makes the scanning process much faster.
11. Select the other options as necessary.
12. Click the Scan button to begin scanning your files.

MetaFuze scans the list of selected paths and forms groups based on the options you have selected.

Once the scan is complete, the main screen displays the list of groups that have been found in the selected paths. After groups have been found, you can proceed to transcode your files.

*If you have selected the Show scanned information option, the Scan Details dialog box opens when all folders have been scanned.*

13. To save the scanned group information, select File > Save project.

Enter a project name that will be easily recognized when you export your MXF data for use in other applications.

## Transcoding your Files

MetaFuze converts groups of scanned files into playable Avid MXF media. You can create several MXF files and export an ALE of these files so that you can easily import them in one step from your editing system.

As MetaFuze transcodes the files, it also embeds the required metadata for tape source, timecode, and key number, so that you can later relink to the original source media for finishing on an editing system such as Avid DS.

Metadata can also be added to MXF files that do not originally contain this information (for example, TIF files). Some of this metadata can be applied as an overlay on the image, much in the same way a telecine transfer would provide window burn-ins of the timecode and key number. Finally, when transcoding, you can also specify a format and a codec to be used to generate the media.
An XML command script can also be used in the Avid MetaFuze console mode to automatically create a list of files for transcoding. For more information, see “Transcoding your Files in a Batch” on page 88.

If you have scanned your files, the Group view at the bottom of the main window displays all groups that have been found. The Group view shows data columns for all possible objects—a group, single-frame file, or transcoded job. However, when you select an object, the Detail view on the right will display only the fields that are pertinent to the selected object. You can customize the group view by adding or removing columns—see “Customizing the MetaFuze Window” on page 75.

To transcode a group:
1. In the Group view, select a group.
2. Preview the sequence of files in the group using the play controls just below the viewers.
Transcoding your Files

The Source viewer displays the original images.

3. In the Detail view, you can experiment with the Format and Conversion Mode options to set the best image format and aspect ratio for your output MXF—see “Detail View” on page 103 for definitions of the different settings.

The Output viewer shows you how the image will appear based on the transcoding settings in the Details view.

4. If you need to select a LUT for your files, click the LUT field in the Detail view.

MetaFuze provides a choice of common industry LUTs that you can use. You also have the option to import a LUT that was provided with your footage—see “Importing a LUT” on page 86.

R3D files have the LUT information encoded in the files themselves, however, you can also import an RLX file which may contain other image settings for the files—see “Importing Other Image Settings” on page 88.

5. You can also select information to burn-in on the frames—see “Burning-in Information on the Frames” on page 84.

6. If you have media that is to be used for stereoscopic display, you will need to scan your left and right image file groups separately—see “Transcoding Files for Stereoscopic Editing” on page 82.

7. When you are ready to convert a group into a single MXF file, click the New Transcode button, or use one of the keyboard shortcuts described below.

A new job is created for transcoding based on the settings in the parent scanned group. There are some fields that are critical to your overall conform workflow, such as key number, tape name, TC start, film type. If you change the settings of these fields in the transcode job, an icon will appear next to them to warn that they are different from the properties of the original scanned group.

The following shortcut keys are available when selecting groups and creating transcode jobs:

<table>
<thead>
<tr>
<th>Option</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>To select or deselect more than one group</td>
<td>Ctrl-click</td>
</tr>
<tr>
<td>To select all groups</td>
<td>Ctrl-A</td>
</tr>
<tr>
<td>To create new transcode jobs for the entire selection</td>
<td>Ctrl-T</td>
</tr>
</tbody>
</table>
Using Avid MetaFuze

You can also create a new transcode job from another transcode job. Simply select the transcode job, change any detail settings, and then click the New Transcode button. The new job will inherit the settings from the original transcode job.

8. Select this new transcode job, and in the Detail view, set the necessary transcode options—see “Detail View” on page 103.

9. In the Detail view, click on the Folder option, and specify a location where the transcoded MXF media is to be saved.

   If you will be using this media on an Avid Media Composer workstation, you can save the media directly to a shared media folder. Select the appropriate drive, and make sure that you save the media in a path name \Avid Media Files\MXF\1. This is the specific path required by Avid Media Composer when you are importing MXF media.

10. Click the Transcode button to begin the transcoding, or use one of the keyboard shortcuts described below.

   The following shortcut keys are available when selecting transcode jobs and generating MXF files:

<table>
<thead>
<tr>
<th>Option</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>To select all transcode jobs</td>
<td>Ctrl-Shift-A</td>
</tr>
<tr>
<td>To generate MXF files for all transcode jobs selected</td>
<td>Ctrl-Shift-T</td>
</tr>
</tbody>
</table>

Depending on the number of frames in the group, this process could take some time to complete. The status bar displays a message while the transcoding process is in progress.

When the transcoding is complete, the MXF file is available in the output folder that you specified. Once a job is transcoded, you cannot change the settings. To create another MXF with different settings, you need to create another transcode job.

Transcoding Files for Stereoscopic Editing

Stereoscopic imaging involves construction of three-dimensional depth information from two images corresponding to pixels in the left and right eye. MetaFuze can transcode files for stereoscopic editorial in Avid Media Composer and Avid DS.

In MetaFuze, you need to scan your left and right image file groups, and select a suitable mode to combine the left and right eye views into a single frame for the transcoding process.
Transcoding your Files

For Avid Media Composer you must use the Over/Under mode with left eye on the top, and right eye on the bottom. MetaFuze can also combine left and right eyes in Side by side, Anaglyph, and Interlaced modes, which are all supported in Avid DS.

To create a stereoscopic group:

1. Scan the appropriate folders as described in “Scanning your Folders” on page 77.

2. In the Groups view, select the folders for the left and right eyes. (The order in which you select your left and right eye groups is important as it determines the order in which the frames will be combined for transcoding. For Avid Media Composer editing, make sure that you select the left eye group first and then the right.)

   To create a stereo group, the left and right eye groups must be of the same file format (frame size and resolution) and have the same duration (number of frames).

3. Click the Create Stereo Group button.
   A new group is created containing the left and right eye groups.

   If you need to change the order of the groups within the stereo group, you can break the group and start again (Actions > Breakup Stereo Group). Breaking a stereo group simply returns the left and right eye groups to the list of standard groups.

4. Select the stereo group and set the necessary options—see “Details of a stereoscopic group or transcode job...” on page 108.

5. After you have set the necessary options, click the Transcode button to begin the transcoding process.
7 Using Avid MetaFuze

Burning-in Information on the Frames

Burn-in data is typically used only for the offline stage of a project. It is useful as it provides visual feedback for logging and tracking footage.

In the Detail view, you can select a data field to burn-in on your images. If you want to burn in more than one field, however, you need to use the Burn-in Editor.

To open the burn-in editor:
1. Select the scanned group and click the **Burn-in** button on the toolbar.
   
   The Burn-in Editor opens—see “Burn-in Editor Dialog Box” on page 110 for details on the settings in this dialog box.

2. Select a Burn-in Preset from the list.
   
   If you want to create a new preset, then click the Save button, and enter a preset filename.

3. Select a field from the Data column, and click the right arrow to add it to the display group.
   
   The field is added to the group and displays in the Output viewer.

4. Change the positioning of the display options as required.
   
   Click any of the Group level columns to change the settings.

5. Continue to add other data fields to the group.
   
   To add a line break, select the <NEW LINE> field from the Data list.
To create a separate group of fields and place it on a different part of the image, select the `<NEW GROUP>` field.

6. Click the Save button to save your settings.
7. Click Close to close the burn-in editor.

**Configuring the MetaFuze Transcoder**

If you have a multiprocessor system, you can increase the number of processing threads that will be used by MetaFuze when transcoding single-frame files such as DPX, JPG or TIF.

**To configure the system transcoder:**

1. From the main menu, select Options > Transcode Configuration.
2. MetaFuze shows the number of threads available on your system for processing.

3. You can raise the number of threads to the maximum, but keep in mind that the processing speed is also limited by the capacity to read and write to the hard disk. You also need to save some threads for other processes/applications running on your system.

*When transcoding stream files such as AVI, MOV or R3D, the threads will be used to their full capacity, therefore you will not be able to use other applications during the transcoding.*
Using LUTs in MetaFuze

A Lookup Table (LUT) is a file that contains a conversion table used to map an input color value to an output color value. When transcoding your files into playable MXF media, you need to set the LUT that came with your footage so that the proper color values are retained throughout the online editing process.

The LUT could come from the film house where the files were scanned, or simply be the LUT associated with the type of camera with which the footage was originally shot.

In the case of R3D files, the LUT information is encoded with the file. In addition, if a certain “look” needs to be applied on this footage, an RLX file will also be provided. This file can be imported into MetaFuze before transcoding your files—see “Importing Other Image Settings” on page 88.

If a LUT was provided with the files you are transcoding, then you should import it into MetaFuze before transcoding the group.

Setting a LUT

After a folder has been scanned, you can set the LUT that will be used for transcoding the scanned files.

To set a LUT:
1. Select the group for which you want to set the LUT.

This field is only available when you are working with a group of DPX or Cineon files.

2. In the Detail View, click LUT and select an appropriate LUT from the drop-down list.

The LUT is loaded and you can preview the color settings in the viewer.

Importing a LUT

If the files you are using have an accompanying LUT either from the film-scanning facility, the camera, or the director of photography, then you will need to import it.

To import an LUT:
1. Select the group for which you want to import the LUT.
2. Click the Edit LUTs button at the bottom of the main view.
3. Select Template > From File.
4. Click Create.
Using LUTs in MetaFuze

5. Browse to the folder where the LUT is located, and click Open.
   The LUT is now available as a choice within MetaFuze.
6. Click Close.

Modifying LUTs

You can edit or create LUTs from the industry LUTs that are provided by MetaFuze.

To edit a LUT:
1. Select the group for which you want to modify the LUT.
2. Click the Edit LUTs button at the bottom of the main view.

   This button is only enabled when you are working with a group of DPX or Cineon files.
3. In the LUT Editor, select a Template type.
4. Click Create.

   A new dialog box opens with the settings of the template.

5. Adjust the values as necessary.

   The Lock option links values to each other. Deselecting this option for an entry allows you to set the values independently.
6. When you are ready to save the settings, click the Rename button.
7. Enter a new LUT Name and click OK.
7 Using Avid MetaFuze

The new LUT is added to the list and will be used for the group that you have selected.

These values can be associated with any group within the current project.

8. Click Close.

Exporting a LUT

You can save the LUT settings and export them for use with other MetaFuze groups or external applications.

To export a LUT:
1. Select the group whose LUT settings you want to export.
2. Click the Edit LUTs button at the bottom of the main view.
3. Select the LUT that you want to export.
4. Click the Export button.
5. Select the folder where you want to place the file, and click Save.
6. Click Close.

Importing Other Image Settings

When transcoding R3D files, you can apply additional settings to enhance the “look” of your file. This is done via an RLX file which contains settings that are very similar to a LUT.

To import an RLX file:
1. Select the transcode group to which you want to apply the settings.
2. In the Detail View, click Import Settings and browse to the folder where your RLX file is located.
3. Select the file and click Open.

The RLX file is loaded and you can preview the color settings in the viewer.

Transcoding your Files in a Batch

You can automate the transcoding process by creating a batch XML file that lists all the groups to be transcoded.
Creating an XML Batch File to Transcode Files

Before you create the XML batch file, you need to have already scanned your folders and created the necessary transcode jobs. With the batch file, each of these jobs is converted into a separate MXF file.

To create the XML batch file:

1. In the Group view, select the transcode job that you want to convert.
2. In the Detail view on the right side of the screen, set the necessary transcode options—see “Create XML Batch Dialog Box” on page 109.
3. Click the Create XML Batch button.
   The Create XML Batch dialog box opens.

4. In the Script Name textbox, type the name of the XML batch file that you want to create.
5. In the Script Output Folder textbox, type the path where the XML batch file will be created.
6. Click OK.
   This creates an .xml batch file using a list of all the files in the transcode job that you have selected. When this batch file is run, the MXF is generated based on the settings for this job.

   An .XSD reference file is also created, which is useful when using a third-party XML validation tool. The XSD file is used to validate the syntax of your batch file.

7. Once you have created your batch file using MetaFuze, you can edit the XML file using a text editor and change your <filelist> as necessary. For an example of an XML file, see “XML Batch File Example” on page 91.
8. When you execute the batch transcode command—see “Running a Transcode Batch File” on page 90. Your XML file will be validated against the XSD to check for the syntax and format.
7 Using Avid MetaFuze

To create an XML file with a third-party application:
1. Generate the .xml and .xsd with MetaFuze.
2. Open the .xml file with Liquid XML Studio from Liquid Technologies (you can download the freeware from http://www.liquid-technologies.com/).
3. Edit your file with Liquid Studio.
4. Use the Validate function in Liquid Studio to validate your .xml file against the .xsd.
5. Option. Open the .xsd with Liquid Studio to find the correct enumeration values.
   Once you have a valid .xml file, it can be interpreted by MetaFuze.

Running a Transcode Batch File

To run the batch transcode:
1. Click the Start button and select Run.
   The Run dialog box opens.
2. Type cmd, and then click OK.
   A Windows console opens.
3. Navigate to C:\Program Files\Avid\MetaFuze
4. At the prompt, type: Metafuze “scriptname.xml” where scriptname is your filename.
   When the command has completed executing, the output files are listed at the end.
XML Batch File Example

A MetaFuze XML batch file contains the same settings found in the Detail view of MetaFuze—see “Detail View” on page 103. The following is an example of an XML batch file:

```xml
<?xml version='1.0' encoding='UTF-8'?>
<MetaFuze_BatchTranscode
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation="MetaFuzeBatchTranscode.xsd">
  <Configuration>
    <Local>2</Local>
    <Remote>2</Remote>
  </Configuration>
  <Group>
    <FileList>
      <File>H:\Public\GraphicsFiles\Still Seq\DPX\253\154_213C-2_B_03\368842.dpx</File>
      <File>H:\Public\GraphicsFiles\Still Seq\DPX\253\154_213C-2_B_03\368843.dpx</File>
      <File>H:\Public\GraphicsFiles\Still Seq\DPX\253\154_213C-2_B_03\368844.dpx</File>
      <File>H:\Public\GraphicsFiles\Still Seq\DPX\253\154_213C-2_B_03\368845.dpx</File>
      <File>H:\Public\GraphicsFiles\Still Seq\DPX\253\154_213C-2_B_03\368846.dpx</File>
      <File>H:\Public\GraphicsFiles\Still Seq\DPX\253\154_213C-2_B_03\368847.dpx</File>
      <File>H:\Public\GraphicsFiles\Still Seq\DPX\253\154_213C-2_B_03\368848.dpx</File>
    </FileList>
  </Group>
</MetaFuze_BatchTranscode>
```
7 Using Avid MetaFuze

    <File>H:\Public\GraphicsFiles\Still Seq\DPX\253\154_213C-2_B_03\368851.dpx</File>

    <File>H:\Public\GraphicsFiles\Still Seq\DPX\253\154_213C-2_B_03\368852.dpx</File>

    <File>H:\Public\GraphicsFiles\Still Seq\DPX\253\154_213C-2_B_03\368853.dpx</File>

    <File>H:\Public\GraphicsFiles\Still Seq\DPX\253\154_213C-2_B_03\368854.dpx</File>

    <File>H:\Public\GraphicsFiles\Still Seq\DPX\253\154_213C-2_B_03\368855.dpx</File>

    </FileList>
- <Transcode>
    <Version>x.0</Version>
    <File>Z:\Project_Documents\VT009_A_09_13_08_04_S01.mxf</File>
    <ClipName>VT009_A_09_13_08_04_S01</ClipName>
    <ProjectName>09</ProjectName>
    <TapeName>SPIRIT-4K DATACINE</TapeName>
    <TC_Start>09:13:08:04</TC_Start>
    <DropFrame>false</DropFrame>
    <FilmType>35.4</FilmType>
    <KN_Start>KU828579-6839+07</KN_Start>
    <Frames>64</Frames>
    <Width>2048</Width>
    <Height>1165</Height>
    <PixelRatio>1.0000</PixelRatio>
    <UseFilmInfo>false</UseFilmInfo>
    <UseTapeInfo>true</UseTapeInfo>
    <OutputVideoFormat>1080_24P</OutputVideoFormat>
Exporting an ALE from MetaFuze

If you have created multiple MXF files that you want to edit on your Avid Media Composer workstation, you can export an edit list of all these clips via an ALE file. The ALE file also contains source information that was found in the files, such as the timecode, keycode, frame rate, and tape name. No sequences or effects are exported.

All transcoded MXF files within an ALE must be of the same frame rate.

To export an ALE:

1. Use Ctrl-click to select all the transcoded files that you want to include in your ALE.
2. Click the Export ALE button.
3. Save the file in an appropriate location.

Importing MXF Files into Avid Media Composer

To import MXF files into Avid Media Composer, you can import the ALE created by MetaFuze and link to the associated MXF files. On the other hand, you can simply open a bin via the Media Tool and select the MXF files one at a time. Either way, you need to make sure that all your transcoded MXF files are located in the Avid MediaFiles folder as required by Avid Media Composer (drive letter:\Avid MediaFiles\MXF\1).

Importing MXF Files via an ALE

When you import the ALE into Avid Media Composer, it displays a log of all the master clips for which you can import MXF media. You will then need to set certain options to link to the master clips.
Using Avid MetaFuze

To import an ALE file using bins:

1. In Avid Media Composer, right-click the bin, and select Import.
2. Browse to the folder where the ALE file is located, select the file, and click Open.
   The bin displays all master clips that have been imported.
3. In the bin, right-click the master clip(s), and select Relink.
4. In the Relink dialog box, deselect the following:
   - Relink only to media from the current project
   - Match case when comparing tape names.
5. Continue setting the options and click OK.
   The MXF files are relinked to the associated master clips.
6. Proceed to edit.

Importing MXF Files

The Media tool displays all captured video and audio data files stored on the media drives. It also displays media that is stored on local drives directly connected to the Avid editing system and on unmanaged shared storage. You can use it to import the MXF files that were transcoded in MetaFuze.

To import an MXF file using the Media Tool:

1. In Avid Media Composer, select Tools > Media Tool.
2. In the Media Tool Display window, select the Media Drive where the Avid MediaFiles folder is located.
   For example, Video U320 (G:).
   The list of Projects will include the name of the MetaFuze project in which you transcoded your files. (Avid Media Composer finds this name in the metadata of the MXF file).
3. Select the name of the MetaFuze project associated with the transcoded MXF files that you want to import.
4. Make sure that only Master Clips is selected and click OK.

Master clips are created in the Media Tool window for any MXF files associated with that project.

5. Drag the clip(s) to a bin and proceed with your editing.

Exporting the AFE File from Avid Media Composer

Once the edits are completed in the Avid Media Composer, export the sequence as an AFE to Avid DS for finishing.

**To export an AFE from Avid Media Composer to Avid DS:**

1. Right-click the sequence and select Send To > Avid DS.

   The Send To: Avid DS dialog box opens with the default export template.

2. Optional: Change the file name.

3. Click Set to browse to the driver and folder to which you want to export the sequence, and click OK.

4. Select Export Settings 1.

   All current settings are displayed in the summary panel below.

5. Click the button after the Export Settings 1, and select Avid DS from the drop-down list.

6. Click the Options button.

   In the Export Settings - Avid DS dialog box opens.
7 Using Avid MetaFuze

7. Select AFE from the Export As drop-down list and click Save.
8. In the Send To: Avid DS dialog box, click OK.
Scan Folders Dialog Box

The following table describes the options available in the Scan Folders dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Available folders    | Allows you to browse to the folder where your source files are located. The folders can be on your local workstation or on a remote storage. (For remote storage, you might need to use the full pathname, e.g. \\
|                      | The folders can be on your local workstation or on a remote storage. (For remote storage, you might need to use the full pathname, e.g. \\
|                      | <machine_name><folder_name>). Press the Enter key after typing in the path name.                                                               |
| Selected paths       | Shows the folders that will be scanned. You can change the order of these folders using the Up and Down arrow buttons. You can also remove a   |
|                      | folder from the list using the X button. The “eye” icon allows you to show all subfolder for any selected path. Simply select a path in the list,  |
|                      | and then click this button to refocus your Available folders view to this path.                                                               |
| Options              | Click this button to show or hide the Options area.                                                                                           |
| Grouping             | Determines the criteria to be used when grouping the files. Use the up or down arrow buttons to set the order of the criteria.               |
| Key Number           | Use the key number as the grouping criteria.                                                                                                  |
| Timecode             | Use the timecode as the grouping criteria.                                                                                                   |
| Filename             | Use the filename. This option is always used.                                                                                                 |
### No merge

Searches for file patterns for each item in the selected paths list, as well as their subfolder levels. Unique groupings are formed for each level.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No merge</td>
<td>Searches for file patterns for each item in the selected paths list, as well as their subfolder levels. Unique groupings are formed for each level.</td>
</tr>
</tbody>
</table>

In this example, 15 searches are done.

![Diagram](file.png)

### Merge across subfolders

For each item in the selected paths list, searches for file patterns down through all the subfolders. Unique groupings are formed for each selected path in your list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merge across subfolders</td>
<td>For each item in the selected paths list, searches for file patterns down through all the subfolders. Unique groupings are formed for each selected path in your list.</td>
</tr>
</tbody>
</table>

In this example, 2 searches are done.

![Diagram](file.png)
Group View

The Group view shows data columns for all possible objects—a group, single-frame file, or transcode job. When you select an object, only the fields that are pertinent to the selected object will display under the appropriate columns (and in the Detail view on the right).

The following table describes the information columns available in the Group view.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merge all</td>
<td>Searches for file patterns and forms groupings across all folders in your list of selected paths.</td>
</tr>
<tr>
<td>Include subfolders</td>
<td>Scans all subfolders in the list of selected paths as shown in the preceding examples. If this option is not selected, only the files at the top level of the selected paths are scanned and grouped.</td>
</tr>
<tr>
<td>File Types</td>
<td>Opens a dialog box where you can select only the files that you want to scan. This can drastically improve the time it takes to scan your folders.</td>
</tr>
<tr>
<td>Show scanned</td>
<td>Displays file details on all groups found, including any duplicate files. This option is useful for analyzing the scan results of a given group.</td>
</tr>
<tr>
<td>information</td>
<td>Scan Begin the scanning process.</td>
</tr>
</tbody>
</table>

For all the preceding merge options, duplicate files are discarded in each grouping and only the most recent is kept.

A single asterisk beside a value indicates that a pattern has been found against this criteria item. However, since it was not the top item of priority in your grouping options, the files might not actually be contiguous for this criteria.
A double asterisk beside a tape name indicates that the information has been generated by MetaFuze based on your entry.

Some column headings have a little arrow at the top right. Click on the arrow to sort the column in ascending or descending order.

<table>
<thead>
<tr>
<th><strong>Column</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the group.</td>
</tr>
<tr>
<td>Folder</td>
<td>Name of folder where this group was found.</td>
</tr>
</tbody>
</table>
| Clip Name           | Indicates the name of the MXF file that will be generated. By default, the name will be taken from the first file in the group, but you can enter a name (using the Detail view) that is more relevant.  
  *If you will be using Avid Media Composer for offlining, you MUST enter a unique name for the clip.* |
| Project             | Indicates the name of the MetaFuze project. You should enter a name that is meaningful, or corresponds to the name of your project on the Avid editing system. |
| Stereoscopic Mode   | Indicates a mode used to combine left and right eye views.                       |
| Set Film Info       | For a standard transcode, indicates if the film information metadata should be embedded in the MXF. |
| Film Type           | Displays the film type found in the source media. If this metadata is not found, then the default is set to 35 mm 4 perfs. |
| KN Start            | The key number found in the first file of the group .  
  If key number metadata was found in the source file, then this field cannot be changed. If the key number was not found in the source file, you will be able to enter a key number if necessary. |
| Set Tape Info       | This option is always selected. Tape information metadata is automatically embedded in the MXF. |
| Tape Name           | The source tape name. For some file types, this name can be changed if necessary. Be careful when changing the name as doing so will not allow you to relink to the source media during the finishing process. |
### Group View

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TC Start</td>
<td>The timecode found in the first file of the group. If timecode metadata was found in the source file, then this field cannot be changed. If the timecode was not found in the source file, you will be able to enter timecode if necessary.</td>
</tr>
<tr>
<td>TC End</td>
<td>Displays the timecode found in the last file of the group.</td>
</tr>
<tr>
<td>Burn-in</td>
<td>Lets you select metadata for burn-in. If you want to burn-in more than one field, see “Burning-in Information on the Frames” on page 84.</td>
</tr>
<tr>
<td>Format</td>
<td>Lets you set the format for the output sequence. The format automatically determines the frame rate, frame size, field dominance, aspect ratio, and pixel ratio for the media. For this version, you can choose between 720p and 1080p HD formats. If frame rate metadata was found in the source file, then the choices for the output format will be based on this frame rate.</td>
</tr>
<tr>
<td>Compression</td>
<td>Lets you select the appropriate compression ratio to be used during conversion. Uncompressed: No compression. DNxHD: Avid DNxHD is a 8- and 10-bit HD encoding technology that delivers mastering-quality HD media with storage bandwidth and capacity requirements similar to those of uncompressed standard-definition (SD) files. Avid DNxHD operates in a 4:2:2 color space at much lower, more efficient data rates. The options available here depend on the Format chosen for the MXF output file. Also, note that 8-bit compression is not available for source media that is 10-bit.</td>
</tr>
<tr>
<td>Conversion mode</td>
<td>Lets you select the aspect ratio that will be used during conversion. When converting between film/HD and NTSC formats, you must make sure that the aspect ratio is respected. Film/HD uses the aspect ratio of 16:9, while NTSC/PAL uses 4:3. Choose the mode that will be used for final output.</td>
</tr>
<tr>
<td>Anamorphic</td>
<td>If your images are 16:9, they are stretched vertically to fit into a 4:3 NTSC frame.</td>
</tr>
</tbody>
</table>
### Avid MetaFuze Reference

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letterbox</td>
<td>Use this option to preserve the aspect ratio when going converting from HD to NTSC. If your images are 16:9, they are placed in the center of the 4:3 NTSC frame and black bars are added to the top and/or bottom of the image. Choose the appropriate letterbox option.</td>
</tr>
<tr>
<td>Pillars</td>
<td>Select this option to preserve the aspect ratio when going from NTSC to HD. The 4:3 image is placed in the center of the 16:9 HD frame and black bars are added to the left and right sides of the image.</td>
</tr>
<tr>
<td>LUT</td>
<td>Enter the type of Lookup Table to be associated with these files. (Only available for DPX and Cineon file types.)</td>
</tr>
<tr>
<td>Nb of frames</td>
<td>Indicates the number of sequential frames found.</td>
</tr>
<tr>
<td>Frame Info</td>
<td>Shows the key number.</td>
</tr>
<tr>
<td>Nb of Duplicates</td>
<td>Indicates the number of duplicate frames found.</td>
</tr>
<tr>
<td>Status</td>
<td>Indicates if this job has been transcoded or not.</td>
</tr>
<tr>
<td>Eye</td>
<td>Enter the appropriate text to indicate the left or right eye frames. This may be useful as burn-in data to provide visual cues on the footage.</td>
</tr>
<tr>
<td>Scene</td>
<td>Enter the name for the scene. This may be useful for burn-in.</td>
</tr>
<tr>
<td>Comment</td>
<td>Enter any comments about the scene or footage. This may be useful for burn-in.</td>
</tr>
<tr>
<td>Chroma</td>
<td>Select the level to filter the noise of the chroma component.</td>
</tr>
<tr>
<td>Debayer</td>
<td>Select the amount of detail correction in the debayering process.</td>
</tr>
<tr>
<td>OLPF</td>
<td>Select the OLPF (Optical Low Pass Filtering) level. This value can be set before capturing or linking.</td>
</tr>
<tr>
<td>ISO</td>
<td>Set the sensitivity of film light. The lower the number the lower the sensitivity of the film.</td>
</tr>
</tbody>
</table>
This view is available after your folders have been scanned and groups have been created based on patterns found in your files. You can select any group, file, or transcode job in the Group view, and the corresponding object details will be shown in the Detail view.

The detail view can be undocked from the main view by clicking the maximize view button in the top right corner. Doing this allows you to stretch out the box if you need to see the values more clearly. It also allows you more viewing space for the other window displays.

The details of transcode jobs are based on settings in the scanned parent group. You can change these settings depending on the output format required for the MXF file. There are some fields that are critical to your overall digital intermediate workflow, such as key number, tape name, TC start, film type. If you change the settings of these fields in the transcode job, an icon will appear next to them to warn that they are different from the properties of the original scanned group.

Refer to the following topics for details on the object you have selected:

- “Details of a group...” on page 104
- “Details of a file...” on page 105
- “Details of a transcode job...” on page 106
- “Details of a stereoscopic group or transcode job...” on page 108
- “Details of R3D groups or transcode jobs...” on page 109

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>The resolution quality of the image being extracted by the RED parser. The higher the resolution, the slower the encoding process.</td>
</tr>
<tr>
<td>Import Settings</td>
<td>You may use Avid DS or a third-party tool to simulate the “look” of your images. These settings (such as black levels, brightness, etc.), can be saved to a file, and applied within MetaFuze to the entire group of images when generating the MXF file. Such an example is the .RLX file which contains metadata for R3D files. Simply specify the name and location of this file here.</td>
</tr>
</tbody>
</table>
## Details of a group...

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the group.</td>
</tr>
<tr>
<td>Folder</td>
<td>Name of the source folder where this group was found.</td>
</tr>
<tr>
<td>Project</td>
<td>Lets you enter a name for this project. This name should be meaningful or correspond to the name of your project in your Avid editing application.</td>
</tr>
<tr>
<td>Film Type</td>
<td>Displays the film type found in the source media. If this metadata is not found, then the default is set to 35 mm 4 perfs.</td>
</tr>
<tr>
<td>KN Start</td>
<td>The key number found in the first file of the group. If key number metadata was found in the source file, then this field cannot be changed. If the key number was not found in the source file, you will be able to enter a key number if necessary.</td>
</tr>
<tr>
<td>Tape Name</td>
<td>The source tape name. For some file types, this name can be changed if necessary. Be careful when changing the name as doing so will not allow you to relink to the source media during the finishing process.</td>
</tr>
<tr>
<td>TC Start</td>
<td>The timecode found in the first file of the group. If timecode metadata was found in the source file, then this field cannot be changed. If the timecode was not found in the source file, you will be able to enter timecode if necessary.</td>
</tr>
<tr>
<td>TC End</td>
<td>The timecode found in the last file of the group.</td>
</tr>
<tr>
<td>Burn-in</td>
<td>Lets you select metadata for burn-in. If you want to burn-in more than one field, see “Burning-in Information on the Frames” on page 84.</td>
</tr>
<tr>
<td>Format</td>
<td>Lets you set the format for the output sequence. The format automatically determines the frame rate, frame size, field dominance, aspect ratio, and pixel ratio for the media. For this version, you can choose between 720p and 1080p HD formats.</td>
</tr>
</tbody>
</table>

*If frame rate metadata was found in the source file, then the choices for the output format will be based on this frame rate.*
Conversion mode

- **Anamorphic**: If your images are 16:9, they are stretched vertically to fit into a 4:3 NTSC frame.
- **Letterbox**: Use this option to preserve aspect ratio when going from HD to NTSC. If your images are 16:9, they are placed in the center of the 4:3 NTSC frame and black bars are added to the top and/or bottom of the image. Choose the appropriate letterbox option.
- **Pillars**: Use this option to preserve the aspect ratio when going from NTSC to HD. The 4:3 image is placed in the center of the 16:9 HD frame and black bars are added to the left and right sides of the image.
- **LUT**: The type of Lookup Table associated with these files. Only available for DPX file types.
- **Nb of Frames**: Number of sequential frames found.
- **Eye**: Enter the appropriate text to indicate the left or right eye frames. This may be useful as burn-in data to provide visual cues on the footage.
- **Scene**: Enter the name for the scene. This may be useful for burn-in.
- **Comment**: Enter any comments about the scene or footage. This may be useful for burn-in.

### Field Name

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name of the selected file.</td>
</tr>
<tr>
<td>Folder</td>
<td>Displays the name of the source folder where this file was found.</td>
</tr>
<tr>
<td>Frame Info</td>
<td>Displays the key number (if applicable), or the frame number.</td>
</tr>
</tbody>
</table>
Details of a transcode job...

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name given to the transcode job.</td>
</tr>
<tr>
<td>Folder</td>
<td>Lets you specify the destination folder for the MXF file.</td>
</tr>
<tr>
<td></td>
<td>If you will be using this media on a Avid Media Composer workstation, you can save the media directly to a shared media folder.</td>
</tr>
<tr>
<td></td>
<td>Select the appropriate drive, and make sure that you save the media in a path name <code>\Avid Media Files\MXF\1</code>. This is the specific path</td>
</tr>
<tr>
<td></td>
<td>required by Avid Media Composer when you are importing MXF media.</td>
</tr>
<tr>
<td>Clip name</td>
<td>Lets you enter the name of the MXF file that will be created from this transcode job.</td>
</tr>
<tr>
<td>Project</td>
<td>Lets you enter a name for this project. This name should be meaningful or correspond to the name of your project in your Avid</td>
</tr>
<tr>
<td></td>
<td>editing application.</td>
</tr>
<tr>
<td>Set Film Info</td>
<td>Select the checkbox to include film information metadata in MXF file.</td>
</tr>
<tr>
<td>Transcode Audio</td>
<td>Select the checkbox to generate MXF files containing the audio portion of the input files.</td>
</tr>
<tr>
<td></td>
<td><em>One MXF is generated per audio channel. If you have multichannel audio, then you will get as many audio MXF files as you have channels.</em></td>
</tr>
<tr>
<td>Wav file</td>
<td>Select the checkbox if you want to generate a WAV file containing the audio portion of the input files.</td>
</tr>
<tr>
<td>Film Type</td>
<td>Displays the film type found in the source media. If this metadata is not found, then the default is set to 35 mm 4 perfs.</td>
</tr>
<tr>
<td>KN Start</td>
<td>The key number found in the first file of the group.</td>
</tr>
<tr>
<td></td>
<td>If key number metadata was found in the source file, then this field cannot be changed. If the key number was not found in the source</td>
</tr>
<tr>
<td></td>
<td>file, you will be able to enter a key number if necessary.</td>
</tr>
<tr>
<td>Set Tape Info</td>
<td>This option is always selected. Tape information metadata is automatically embedded in the MXF.</td>
</tr>
<tr>
<td>Tape Name</td>
<td>The source tape name. For some file types, this name can be changed if necessary.</td>
</tr>
</tbody>
</table>
Details of a transcode job...

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TC Start</td>
<td>The timecode found in the first file of the group. The start timecode can be changed if necessary, and the end timecode will automatically be adjusted.</td>
</tr>
<tr>
<td>TC End</td>
<td>The timecode found in the last file of the group.</td>
</tr>
<tr>
<td>Burn-in</td>
<td>Lets you select metadata for burn-in. If you want to burn-in more than one field, see “Burning-in Information on the Frames” on page 84.</td>
</tr>
<tr>
<td>Format</td>
<td>If a frame rate was not detected in the source media (e.g. for PNG files), then you can set the format for the output sequence. The format automatically determines the frame rate, frame size, field dominance, aspect ratio, and pixel ratio for the media. For this version, you can choose between 720p and 1080p HD formats.\n\nIf frame rate metadata was found in the source file, then the choices for the output format will be based on this frame rate.</td>
</tr>
<tr>
<td>Compression</td>
<td>Lets you set the appropriate compression ratio.</td>
</tr>
<tr>
<td>Uncompressed</td>
<td>No compression. Capable of handling 8- and 10-bit files.</td>
</tr>
<tr>
<td>DNxHD</td>
<td>Avid DNxHD is a 8- and 10-bit HD encoding technology that delivers mastering-quality HD media with storage bandwidth and capacity requirements similar to those of uncompressed standard-definition (SD) files. Avid DNxHD operates in a 4:2:2 color space at much lower, more efficient data rates. The options available here depend on the Format chosen for the MXF output file.</td>
</tr>
<tr>
<td>Conversion mode</td>
<td>Lets you select the aspect ratio that will be used during conversion. When converting between film/HD and NTSC formats, you must make sure that the aspect ratio is respected. Film/HD uses the aspect ratio of 16:9, while NTSC/PAL uses 4:3. Choose the mode that will be used for final output.</td>
</tr>
<tr>
<td>Anamorphic</td>
<td>If your images are 16:9, they are stretched vertically to fit into a 4:3 NTSC frame.</td>
</tr>
<tr>
<td>Letterbox</td>
<td>Use this option to the preserve aspect ratio when going converting from HD to NTSC. If your images are 16:9, they are placed in the center of the 4:3 NTSC frame and black bars are added to the top and/or bottom of the image. Choose the appropriate letterbox option.</td>
</tr>
</tbody>
</table>
Details of a stereoscopic group or transcode job...

The following additional options are available when you select groups or transcode jobs that have stereoscopic files—see “Transcoding Files for Stereoscopic Editing” on page 82.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereoscopic Mode</td>
<td>Select a mode to combine the left and right eye views into a single frame for the transcoding process.</td>
</tr>
<tr>
<td>Interlaced</td>
<td>Interleaves every alternate line from the left and right eye images into a single frame.</td>
</tr>
<tr>
<td>Over/Under</td>
<td>Places the left and right eye images one above the other in a horizontal split frame.</td>
</tr>
<tr>
<td>Side by Side</td>
<td>Places the left and right eye images side by side in a vertical split frame.</td>
</tr>
<tr>
<td>Anaglyphic</td>
<td>Each left and right eye image is made up of two color layers which are superimposed to create a stereoscopic depth effect that can be viewed with two-color 3D glasses.</td>
</tr>
</tbody>
</table>
Details of R3D groups or transcode jobs...

The following additional options are available when you select groups or transcode jobs that have R3D files.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chroma</td>
<td>Select the level to filter the noise of the chroma component.</td>
</tr>
<tr>
<td>Debayer</td>
<td>Select the amount of detail correction in the debayering process.</td>
</tr>
<tr>
<td>OLPF</td>
<td>Select the OLPF (Optical Low Pass Filtering) level. This value can be set before capturing or linking.</td>
</tr>
<tr>
<td>ISO</td>
<td>Set the sensitivity of film light. The lower the number the lower the sensitivity of the film.</td>
</tr>
<tr>
<td>Black Level</td>
<td>Adjust the black level.</td>
</tr>
<tr>
<td>Resolution</td>
<td>The resolution quality of the image being extracted by the RED parser. The higher the resolution, the slower the encoding process.</td>
</tr>
<tr>
<td>Import Settings</td>
<td>Load an existing RLX file. Use the browse button to find and load the file.</td>
</tr>
</tbody>
</table>

Create XML Batch Dialog Box

The following table describes the XML batch file options available in the Batch Transcode dialog box.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script Name</td>
<td>Enter the name for the XML file that is to be created.</td>
</tr>
<tr>
<td>Script Output Folder</td>
<td>Enter the path where the files will be placed.</td>
</tr>
<tr>
<td>XML Schema (*.xsd)</td>
<td>Creates a file, called MetafuzeBatchTranscode.xsd, containing XML-based schema. This file can be used by a third-party tool to validate the format and syntax of your .xml batch files when executing the batch transcode command.</td>
</tr>
</tbody>
</table>
Burn-in Editor Dialog Box

The following table describes the options available in the Burn-in Editor dialog box.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Burn-in Preset</td>
<td>The name of the file where the settings are stored.</td>
</tr>
<tr>
<td>Save button</td>
<td>Click this button to create a new preset, or save changes to a selected preset.</td>
</tr>
<tr>
<td>Delete button</td>
<td>Click this button to delete a selected preset.</td>
</tr>
<tr>
<td>Import</td>
<td>Import a burn-in preset file (.xml).</td>
</tr>
<tr>
<td>Export</td>
<td>Export a burn-in preset file (.xml).</td>
</tr>
<tr>
<td>Data</td>
<td>A list of data fields that can be burned-in on your images.</td>
</tr>
<tr>
<td></td>
<td>NEW LINE - inserts a line break between data fields.</td>
</tr>
<tr>
<td></td>
<td>NEW GROUP - creates a new group of data fields.</td>
</tr>
</tbody>
</table>

Group columns:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the selected data field.</td>
</tr>
<tr>
<td>% Y</td>
<td>Percentage offset on the Y axis.</td>
</tr>
<tr>
<td>% X</td>
<td>Percentage offset on the X axis.</td>
</tr>
<tr>
<td>Horizontal</td>
<td>Horizontal position of group.</td>
</tr>
<tr>
<td>Vertical</td>
<td>Vertical position of group.</td>
</tr>
<tr>
<td>Font</td>
<td>Font type to use for display.</td>
</tr>
<tr>
<td>Size</td>
<td>Font size to use for display.</td>
</tr>
<tr>
<td>Separator</td>
<td>Symbol to use for separation between data fields.</td>
</tr>
<tr>
<td>Luminance</td>
<td>Controls the luminance of the burn-in text. The range is between 0 and 100 where 0 is full black text and 100 is full white text. Default setting: 100.</td>
</tr>
</tbody>
</table>

Transcode Configuration Options

If you have a multiprocessor machine, you can set the number of threads that can be used by MetaFuze.
Increasing the number of processing threads generally provides greater performance, but it may decrease the power of other applications that are running simultaneously.

When transcoding stream files such as AVI, MOV or R3D, the threads will be used to their full capacity, therefore you will not be able to use other applications during the transcoding.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Number of Threads</td>
<td>Set the number of processing threads to be used when reading/writing files locally.</td>
</tr>
<tr>
<td>Remote Number of Threads</td>
<td>Set the number of processing threads to be used when reading/writing files remotely.</td>
</tr>
</tbody>
</table>
Index

Numerics
2K files, importing 8
3D LUT Generator 70

A
audio
  transfer from film 47
Avid Unity
    configuring storage in Avid DS 31

B
bit depth
  for film 38

C
capturing
  heads and tails 51
  oversized images 42
  timecode breaks 53
Cineon files
  importing 8
color space
  for film and HD projects 37

D
DPX files
  importing 8
  storage 27

E
EDL (Edit Decision List)
  loading 40
external device
  checking status 62

F
film
  audio transfer 47
  bit-depth, setting 38
  formats 35
  outputting sequence 59
  project, creating 35
  quality settings 38
  storage 27
  storage, project considerations 27
  working in proxy mode 57
  film master 35
  film proxy 27

H
handles
  setting for capture 51
heads
  adding preroll and post-roll for capture 51

I
importing
  2K files 8
  DPX files 8
  files by reference 42
  images, oversized 42
  linked clips 42

L
linked clips
  creating 42

N
numeric keypad, using during capture 52
Index

O
output
  checking external device status 62
  selecting channels, tracks, and clips 63
  to tape, procedure 61
oversized images, importing 42

P
post-roll
  recording 51
preroll
  insufficient material for capture 53
  setting custom (Capture Tool) 49
  setting custom (Output Tool) 63
project
  for film 35
proxy
  film 27
  real-time 27
proxy mode
  for film 57
  preferences settings 58

R
real-time proxy
  resolution 55, 57
  setting 58
  using 57
resolution
  proxy 55, 57
  real-time proxy 55, 57
  setting real-time proxy 58
RGB 4:4:4
  color space 37

S
sequence, outputting film 59
storage
  adding 30
  Avid Unity 31
  for film 27, 27

tails
  adding for capture 51
timecode
  breaks, during capture 53
tools
  3D LUT Generator 70